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Support

We work closely with our reseller partners to offer the best worldwide technical support services. Your reseller

is the first line of support when you have questions about products and services. However, if you require

additional assistance you can contact us directly at:

Telephone

You can call our help-desk 24 hours a day, seven days a week:
USA: 1-800-545-6608
International: +1-410-931-7520

Email

You can send a question to the technical support team at the following email address:

support@safenet-inc.com

Website

You can submit a question through the SafeNet Support portal:
https://serviceportal.safenet-inc.com

Additional Documentation
The following SafeNet publications are available:

m SafeNet Authentication Client 8.3 Build 73 User’s Guide
m  SafeNet Authentication Client 8.3 Build 73 Customer Release Notes
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Introduction

SafeNet Authentication Client (SAC) enables token operations and the implementation of token
PKI-based solutions.

In this chapter:

Overview

SafeNet Authentication Client Main Features
What's New

Supported Tokens

Supported Localizations

SafeNet Authentication Client Architecture
License Activation

1. Introduction /
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SafeNet Authentication Client is Public Key Infrastructure (PKI) middleware that provides a secure
method for exchanging information based on public key cryptography, enabling trusted third-party
verification of user identities. It utilizes a system of digital certificates, Certificate Authorities, and
other registration authorities that verify and authenticate the validity of each party involved in an
internet transaction.

SafeNet Authentication Client enables the implementation of strong two-factor authentication using
standard certificates as well as encryption and digital signing of data. Generic integration with CAPI,
CNG, and PKCS#11 security interfaces enables out-of-the-box interoperability with a variety of security
applications offering secure web access, secure network logon, PC and data security, and secure
email. PKI keys and certificates can be created, stored, and used securely from within hardware or
software tokens.

1. Introduction / Overview
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Cryptography API: Next Generation (CNG)

CNG is the long-term replacement for the CryptoAPI. CNG is designed to be
extensible at many levels, and it is cryptography-agnostic in behavior.

CNG includes support for Suite B algorithms, enabling the selection of SHA-2
algorithms for tokens used with SafeNet Authentication Client.

CNG currently supports the storage of asymmetric private keys by using the
Microsoft software Key Storage Provider (KSP) that is installed by default with
Windows Server 2008 and Windows Vista.

Key Storage Provider (KSP)

KSP is a software library that implements the standard CNG key storage provider
plug-in interfaces and is registered with the CNG system. This enables applications
to choose different mechanisms for key storage, such as software, smartcards, or
hardware security.

SafeNet Authentication Client can be deployed and updated using any standard software distribution
system, such as Windows Group Policy Objects (GPO) or Microsoft System Management Server (SMS).

The SafeNet Authentication Client Tools application and the SafeNet Authentication Client tray icon
application are installed with SafeNet Authentication Client, providing easy-to-use configuration tools
for users and administrators.

1. Introduction / Overview
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SafeNet Authentication Client incorporates features that were supported by previous releases of

eToken PKI Client and SafeNet Borderless Security (BSec). It provides a unified middleware client for a
variety of SafeNet smartcards, SafeNet iKey tokens, and SafeNet eToken devices.

SafeNet Authentication Client offers full backward compatibility so that customers who have been
using eToken PKI Client or SafeNet Borderless Security Client (BSec) can continue to use deployed
eToken and iKey devices.

NOTE
Future versions of SafeNet Authentication Client may not support BSec-compatibility.

SafeNet Authentication Client includes the following features:

m Token usage, including:

¢

¢
¢
¢

Digitally signing sensitive data

Remote data access

SafeNet eToken Virtual use
Management of certificates on the token

1. Introduction / SafeNet Authentication Client Main Features
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= Token management operations, including:

Token initialization

Token Password changes

Token unlock

Configuration of token settings and Token Password quality
Token renaming

Logging

m SafeNet Authentication Client settings configuration

m  SafeNet Authentication Client Customization Tool

® & & o oo o

1. Introduction / SafeNet Authentication Client Main Features
SAC 8.3 Build 73 - Administrator’s Guide, 007-012450-001 - Revision C, ©2014 SafeNet, Inc. O K€ 13 > M



SafeNet Authentication Client 8.3 offers the following new features:

= Windows 8.1 support

m  Each SafeNet eToken 7300 (Standard and HID) device initialized using SafeNet Authentication
Client 8.3 can be used on both Windows and MAC computers even where SafeNet Authentication
Client is not installed

m  Each SafeNet eToken 5200/5205 HID device can be used on both Windows and MAC computers
even where SafeNet Authentication Client is not installed

= New common SafeNet Authentication Client tray icons and tray menu user interface for both
eTokens and iKey tokens

m  eToken 7300 CD-ROM update (supported via SDK)

NOTE
There is no 8.3 release of the BSec Utility package. Continue to use BSec Compatibility Utilities Package 8.2.
Future versions of SafeNet Authentication Client may not support BSec-compatibility.

1. Introduction / Whats New Q
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SafeNet Authentication Client 8.3 supports the following tokens:

SafeNet eToken PRO

SafeNet eToken PRO Anywhere

SafeNet eToken PRO Smartcard

SafeNet eToken 7300 (standard and HID)
SafeNet eToken 5100/5105

SafeNet eToken 5200/5205

SafeNet eToken 5200/5205 HID

SafeNet eToken 4100

SafeNet eToken 7000 (SafeNet eToken NG-OTP)
SafeNet eToken 7100 (SafeNet eToken NG-Flash)
SafeNet eToken NG-Flash Anywhere

SafeNet eToken Virtual Family

SafeNet iKey: 2032, 2032u, 2032i

SafeNet Smartcard: SC330, SC330u, SC330i
SafeNet Smartcard SC400

SafeNet iKey 4000

1. Introduction / Supported Tokens

SAC 8.3 Build 73 - Administrator’s Guide, 007-012450-001 - Revision C, ©2014 SafeNet, Inc.

J

e <

15

> M



NOTE
Localizations are not supported in the BSec Utility applications.

SafeNet Authentication Client 8.3 supports the following languages:
Chinese (Simplified)
Chinese (Traditional)
Czech

English

French (Canadian)
French (European)
German

Hungarian

Italian

Japanese

Korean

Lithuanian

Polish

Portuguese (Brazilian)

1. Introduction / Supported Localizations
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Romanian
Russian
Spanish
Thai
Vietnamese

1. Introduction / Supported Localizations » Y
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SafeNet Authentication Client Architecture

Applications that usa M5 cryplography Applications that do nol use M5 cryplography
Examples: Examples:
*  ME Oulook »  Firedon
= Inftemel Explorer = SafeMNel Authenlication Clien Tools
« Safaket Avthentication Manager *  Pre-Boot Authertication
Y Y
Microsof cryplographic APl PKCS#11 APls
Examples: Microsolt Key Storage AP (KSP): - SAC's PHCSA11 + extensions

s Firefox
«  Safehet Authentication Client Tools
=  Pre-Bool Authenlication

Bagc's PECS#11 » axlensions (Bsec

« SafeMet Smart Card Key Slorage Provider .
compatible)

o aToken
- m,
Y
Supporied tokens and smart cards
1. Introduction / SafeNet Authentication Client Architecture
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By default, SafeNet Authentication Client 8.3 is installed as licensed for evaluation only.

To install a non-evaluation license:
1 Obtain a valid SAC License Key from SafeNet Customer Service.
2 Activate the license using one of the following procedures:
¢ Manual Activation
See the Licensing chapter in the SafeNet Authentication Client 8.3 User’s Guide.

¢ Command Line Activation
See License Settings on page 191 (Command Line column) and Installing via the Command
Line on page 98.

¢ Group Policy Object Editor
See License Settings on page 191 (ADM File Setting column) and Setting SafeNet
Authentication Client Properties on page 172.

¢ SafeNet Authentication Client Customization Tool
You can specify the license key when creating a customized MSI Installation file.

See Using the SafeNet Authentication Client Customization Tool, step 3, on page 43.

1. Introduction / License Activation
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System Requirements

Before installing SafeNet Authentication Client, ensure that your system meets the minimum
requirements.

In this chapter:

m  Supported Browsers

Supported Platforms

Hardware and Screen Resolution Requirements
Compatibility with SafeNet Applications
Compatibility with Third-Party Applications

2. System Requirements /
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SafeNet Authentication Client 8.3 supports the following browsers:

m  Firefox 5 and later
m  Internet Explorer 7, 8, 9, 10, 11, Metro
= Chrome version 14 and later, for authentication only (Does not support enrollment)

2. System Requirements / Supported Browsers
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SafeNet Authentication Client 8.3 supports the following operating systems:

Windows XP SP3 (32-bit, 64-bit)
Windows Server 2003 SP3 (32-bit, 64-bit)
Windows Server 2003 R2 (32-bit, 64-bit)
Windows Vista SP2 (32-bit, 64-bit)
Windows Server 2008 SP2 (32-bit)
Windows Server 2008 R2 SP1 (64-bit)
Windows Server 2012 (64-bit)

Windows Server 2012 R2 (64-bit)
Windows 7 SP1 (32-bit, 64-bit)
Windows 8 (32-bit, 64-bit)

Windows 8.1 (32-bit, 64-bit)

NOTE
¢ To use a KSP cryptographic provider, Windows Vista or higher is required.

¢ In Windows 8.1 environments, SafeNet eToken 7300 devices earlier than version 9.0.35 can be used only when SafeNet
Authentication Client is installed.

2. System Requirements / Supported Platforms
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The following Mac operating systems support SafeNet eToken 7300 devices initialized using SafeNet
Authentication Client 8.3, and SafeNet eToken 5200/5205 HID devices:

®  Mac OS X 10.8 (Mountain Lion)
® Mac OS X 10.7.3 and 10.7.4 (Lion)

= MAC OS X 10.9.1 (Mavericks)

2. System Requirements / Supported Platforms
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Hardware and Screen Resolution Requirements

Required hardware:
m  USB port, for physical token devices
Recommended screen resolution:

m 1024 x 768 pixels and higher, for SafeNet Authentication Client Tools

2. System Requirements / Hardware and Screen Resolution Requirements
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Compatibility with SafeNet Applications
SafeNet Authentication Client 8.3 works with the following SafeNet products:

eToken Devices

= SafeNet Network Logon 8.0
m  SafeNet Authentication Manager 8.0 and later
m  eloken Minidriver 5.1 (Java cards only)

2. System Requirements /| Compatibility with SafeNet Applications
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SafeNet Authentication Client 8.3 works with the following products:

¢
¢
¢
¢

Juniper Secure Access
RDP Windows Logon
Entrust ESP 9.0 and later (Entrust EDS and ESP applicable to iKey 2032i, SC330i, iKey 4000)
Citrix XenApp 5.0, XenApp 6.0, XenApp 6.5, Citrix XenDesktop 5.6

Cisco AnyConnect, Cisco ASA, Cisco VPN Client
IdenTrust

MS Office 2007, 2010, 2013

Adobe Acrobat 9, X, XI

VMware Workstation

Certificate Authorities:

Microsoft CA 2003 / R2

Microsoft CA 2008 / R2, Microsoft CA 2012 / R2
VeriSign CA

Entrust Authority Security Manager 8.1

®  Microsoft FIM/ILM

2. System Requirements /| Compatibility with Third-Party Applications
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J

M€ € 26

> M



= VPNs:
¢ Microsoft VPN
¢ Cisco VPN
¢ Check Point VPN
m  MyID (Intercede) - for iKey devices only

2. System Requirements /| Compatibility with Third-Party Applications
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Installation Files and
Administrator Tasks

The software package provided by SafeNet includes files for installing or upgrading to SafeNet
Authentication Client 8.3.

In this chapter:
m Installation Files
m  Checklist of Administrator Tasks

3. Installation Files and Administrator Tasks /
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The following installation, migration, and documentation files are provided:

Environ

File et Description Use

SafeNetAuthenticationClient-x32- 32-bit Installs SafeNet Use to install SafeNet

x64-8.3.exe 64-bit Authentication Client 8.3, Authentication Client 8.3, and to

SafeNetAuthenticationdl 3 32-b1 and upgrades from earlier upgrade from:

8a3e etAuthenticationClient-x32- it versions of SafeNet ¢ SafeNet Authentication Client 8.0
-2.Msl Authentication Client and and later

SafeNetAuthenticationClient-x64-  64-bit eToken PKI Client # eToken PKI Client 5.1 SP1

8.3.msi

SafeNetAuthenticationClient- 32-bit Installs SafeNet Use to install SafeNet

eToken-x32-8.3.msi Authentication Client 8.3 for = Authentication Client 8.3 for eToken

S i ) eToken devices only devices only (without BSec
SafeNetAuthenticationClient- 64-bit

eToken-x64-8.3.msi

(without BSec
components), and upgrades
from earlier versions of
SafeNet Authentication
Client and eToken PKI Client
for €Token devices only

components), and to upgrade from:

¢ SafeNet Authentication Client 8.0
and later

¢ eToken PKI Client 5.1 SP1
for eToken devices only

3. Installation Files and Administrator Tasks / Installation Files
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File

SACCustomizationPackage-8.3.exe

SafeNetAuthenticationClientPackag
e-8.3.exe

PolicyMigrationTool.exe

SAC_CRN_8_3_Rev_A.pdf

SAC_User_Guide_8_3_Rev_A.pdf

Environ
ment

32-bit
64-bit

32-bit

32-bit

Description

Installs SafeNet
Authentication Client 8.3
Customization Package, and
upgrades from SafeNet
Authentication Client 8.1
and later Customization
Packages

Upgrades to SafeNet
Authentication Client 8.3
from BSec

Migrates policy
configurations and registry
key settings from BSec to
SafeNet Authentication
Client

SafeNet Authentication
Client 8.3 Customer Release
Notes

SafeNet Authentication
Client 8.3 User’s Guide

Use

Use to customize SafeNet
Authentication Client installation
with non-default settings

Use to upgrade from BSec 7.2.0 and
later

Use to import existing settings from
a BSec installation earlier than 7.2.0
following upgrade to SafeNet
Authentication Client

Read before installation for last
minute updates that may affect
installation; contains important
information such as resolved and
known issues and troubleshooting

Provides detailed information for the
user and system administrator
regarding the use of SafeNet
Authentication Client

3. Installation Files and Administrator Tasks / Installation Files
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Environ

File e Description Use
SAC_Admin_Guide_8_3_Rev_A.pdf SafeNet Authentication Provides detailed information for the
Client 8.3 Administrator’s system administrator regarding the
Guide (this document) installation, configuration,
maintenance, and management of
SafeNet Authentication Client
NOTE

SafeNetAuthenticationClient-BSecUtilities-8.2.msi, which installs legacy BSec Utilities that can be used with BSec-compatible
SafeNet Authentication Client versions 8.2 and 8.3, is not packaged with SafeNet Authentication Client 8.3. It is provided in
the SafeNet Authentication Client 8.2 installation folder.

3. Installation Files and Administrator Tasks / Installation Files
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If upgrading from eToken PKI Client or BSec, determine if the registry keys are to be cleared before
installing SafeNet Authentication Client.

¢ For upgrading from eToken PKI Client, see Upgrading from eToken PKI Client on page 77.
¢ For upgrading from BSec, see Upgrading from SafeNet Borderless Security (BSec) on page 79.

Customize the SafeNet Authentication Client default installation features, if required, to create a
customized SafeNet Authentication Client 8.3 installation.

¢ See Customization on page 34.
If a previous version of SafeNet Authentication Client is already installed:

¢ For upgrading using the installer file, see Simplified Upgrade on page 74.
¢ For upgrading using the msi file, see Upgrading Using MSI on page 76.

If not upgrading, install SafeNet Authentication Client on each computer on which a token is to be
used.

¢ For installing via the installation wizard, see Installing via the Wizard on page 90.
¢ For installing via the command line, see Installing via the Command Line on page 98.

Customize the SafeNet Authentication Client settings, if required, and update all client computers.

See SafeNet Authentication Client Settings on page 134.

3. Installation Files and Administrator Tasks / Checklist of Administrator Tasks
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Initialize and manage tokens.

¢ See the Token Initialization and Token Management chapters in the SafeNet Authentication
Client User’s Guide.

3. Installation Files and Administrator Tasks / Checklist of Administrator Tasks
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Customization

The SAC installation features and the graphic user interface provided by SafeNet can be customized
for your installation.

NOTE

.Net Framework 2.0 or higher is required on all operating system when running the SafeNet Authentication Client
Customization Tool.

In this chapter:

Customization Overview

Installing the SafeNet Authentication Client Customization Tool
Using the SafeNet Authentication Client Customization Tool
Generating a Customized MSI Installation File

Installing the Customized Application

4, Customization /
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You can customize the following SafeNet Authentication Client 8.3 features:

m  Product name, which appears in the installation wizard, the Ada/Remove program, and the About
window

Destination folder

URL of the support link in the Add/Remove program

License string

SafeNet Authentication Client features to be installed

Policy settings

MSI Signing settings

Window banners

4. Customization / Customization Overview
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Before installing SafeNet Authentication Client, install the SafeNet Authentication Client Customization
Tool.

To install the SafeNet Authentication Client Customization Tool:

1 Double-click SACCustomizationPackage-8.3.exe.
The SafeNet Authentication Client Customization Package Installation Wizard opens.

4. Customization / Installing the SafeNet Authentication Client Customization Tool
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i Safehet Authentication Client Customization Packape

Welcome to the SafeMet Authentication

Client Customization Package
SafENEt. : Installation Wizard
Authentication
Client The Setup wizard il intal Sofehet Autheniication Clent
Customization Package on youn computer.
It i strongly recammended that you close all'Windows programs:

b U bedore running the S etup wizard

2 C(Click Next.
The License Agreement is displayed.
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i SafeNet Authentication Client Customization Packape

License Agreement

Plaaze read Hhe loliowing Boense agreemend canshaly. SafeiMet.

SOFTWARE LICEMNSE AGREEMENT

IMPORTANT - READ THESE TERMS CAREFULLY BEFORE DOWHNLDADING,
IMSTALLIMG OR USIMG THIS SOFTWARE. BY DOWHNLDADING OR
IMSTALLIMG THIS SOFTWARE, YOU ACKNOWLEDGE THAT YOU MAVE
READ THIS LICEMSE AGREEMENT, THAT ¥YOU UNDERSTAMND IT, AMD THAT
YOU AGREE TOD BE BOUMND BY ITS TERMS. IF YOU DO NOT AGREE TO THE
TERMS AND CONDITIONS OF THIS LICENSE AGREEMENT, ¥YOU MAY NOT
INSTALL DR USE THIS SOFTWARE.

1. Grant of License for Personal Use,

SafeNet, Inc. ("Satelet™) grants you & non-exclusive, non-transferable licanse &

(11 accept the Bopnas agresment
(%) 1 do rot accept the Boonse agresment

(o] o

3 Read the license agreement, and select the option, I accept the license agreement.
4 Click Next.

The Destination Folder window opens, displaying the default installation folder.
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i SafeNet Authentication Client Customization Packape

Destination Folder
Selact & Foldes i which the spplicston wall be nshalied

Sesboursg Bokdes

Destination Folder
C-\Progearn Files\5 aleMat\Autherhcsbon’

Sestup vl ingtall the fes or 5 afeblet dathertecstion Chert Cushomization Packags in the

To mstall m a diferent lolder, chick Biowse, and select ancther fokder,

Biowita

¢ Back ]_

Heot> | [ Cancel |

5 You can click Browse to select a different destination folder, or install the Customization Tool’s
SACAdmin folder into the default folder:
C:\Program Files\SafeNet\Authentication\

NOTE

If an application from the SafeNet Authentication line of products, or an €Token legacy product, is already installed, we
recommend that the destination folder not be changed.

6 Click Next to start the installation.
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When the installation is complete, the SafeNet Authentication Client Customization Package has
been successtully installed window opens.

i SafeMet Authentication Client Customization Packape -

SafeNet Authentication Client

SafeNet Customization Package has
Authentication been successfully installed.
Client ,

Chick Finish to exit Setup

7 Click Finish to exit the wizard.
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After installing the SafeNet Authentication Client Customization Package, customize the appropriate
features.

To use the Customization Tool:

1 From the Windows Start menu, select Programs > SafeNet > SACAdmin > SAC
Customization Tool.

The SafeNet Authentication Client Customization Too/ opens to the General Settings tab.

4. Customization / Using the SafeNet Authentication Client Customization Tool/
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& Safelet Authenticatian Client - Custemnizatian Tool: Prajecil

G ermstal Setteas
ﬁ Froduct Hame S alehet Autherticstion Clent .3
[Gznies o 5 et
Dipstration Foldet | |Byom i ilesF obder 15 slebl et Suthenic.ston w
- Suppart UAL it e, sibesneed v Com Bt hesniio Ston
Fandurss 15 il
Liceraa Sting Load from File

2 To open a project you already saved, select File > Open, and browse to the xml file of an existing
project.
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3 You can replace the following items:

¢ Destination folder path to be used by the SafeNet Authentication Client Customization Tool
when no other SafeNet product has been installed on the client computer

URL to be displayed in the Windows Add/Remove Programs support link

License string to be installed: either paste to the box, or click Load from File, and browse to
the .lic file containing the SafeNet Authentication Client license

4 In the left column, select the Features to Install tab.
The Features to Install window opens.
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& Safebet Authenticatian Client - Custemizatian Tool: Project

Fle  Actons  Help
Festunes ha beatal
i
¥
Q aToken devers
Ganerd Settings E' B5ec vt
[#] aToken CAPY
1 [] eTohen 5aRt
[Fsiuras o Iniall
[#] aToken FSFestun
il SAL Took
Prlicy Satings
d\i
W5 Sagring
Gl

[#] Enivust suapeost
] BSec FECSE
] BSec CAPY

] vdonTrsi supgent

5 You can select which features will be installed when the SafeNet Authentication Client

Customization Tool is run:
¢ eloken Drivers

¢ BSec Drivers

¢ eToken CAPI
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NOTE
Ensure that e7oken CAPI is selected.

eToken SAPI
eToken FSFeature
SAC Tools

Entrust support
BSec PKCS#11
BSec CAPI
IdenTrust support

® & & & o oo o

NOTE
If IdenTrust supportis selected, ensure that BSec PKCS#11 is selected also.

For more information, see Chapter 7: Command Line Installation Features, on page 117.

6 In the left column, select the Policy Settings tab.
The Policy Settings window opens.
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& Safebet Authenticatian Client - Custemizatian Tool: Project

Proby Seftrags

o= = 53] Saieblist futherdscation Clerd
Al ) General Setrgs
# ] TokenDioman Parmwoed Sesirgs
Ganerd Settings a1 L) Ieabiskrabor Sofrgs

i) Took Ul Indisizston 5 etings
o # L] Took LI Settingt
a1 () ICAFY Ssmegga
EI # L] Cestificate Siore Settings
i [0) CHE Key Stoage Provide Seltng:

#l ) Token Password Quslly Settings
# [ Took LI Access Contol List

a1 ) Resdal Seitng:
@ # ] Secusity Setting:

Faasbungs o lrbal

7 You can override the application’s default values by changing the configuration properties to be
written to the registry keys. These new values are saved in
HKEY LOCAL MACHINE/SOFTWARE/Policies/SafeNet/Authentication/SAC.

For more information, see Chapter 10: Configuration Properties, on page 170.
For each setting to be changed, expand the appropriate node, select the setting, and change its
value.
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& SafeMet Authenticatban Client - Custemizatian Tool: Prajectl

Fle adions  Hep

Fshunss s binihal
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|

Polcy Satiings

2

WSl Sagring

&%

Gl

Prokoy Seftrags

@[] Intiskration Safirgs

a1 () Towods U1 skt S sttinge

# L Tocls Ul Settings

@ L) CAF1 Semrgs

#i () Cestificate Siore Settings

# (2] CHG Key 5ioeags Frowide Saltng:

= 5y Tokusn Passieord Quashly Sertngs

# ad Token Paepeoed Evpsation ‘W aming Setings

(@] Pagswornd - Mraves Langth
| Paaswond - Maivem Lengh
(@] Pagzwond - Macdmum |nage Pecd
(@] Paaswond - M Usege Petod
[@] Psswweond - Eparation W asring Peniod

@ | Passwond - Madmem Consecutive Fepetiiony
(@] Paszwond - Complesy
(3] Paaaiwond - Miraviss Messd Clranscsl Tppss
[%] Passwond - Inchade Numessly
[@] Passwond - Inchade Lipper Cace
@] Passwond - Inchade Lower-Case
[@] Paszwond - Inchade Specisl Chaacter
(@] Paasiond Quasbly Cheschl o Irahake Sl
@] Paaswond Tasity Twner
[ Erealble Partwectd Qualty Modication
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E splanaton
Disfreng: e ruambent of pacend paspacids: that
Frnp Pt B ringsbatae]

Wk
= yaul)
10 = M warirraas|

= Dl 10

8 In the left column, select the MSI Signing tab.

The MSI Signing window opens.
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& SafeMet Authenticatban Client - Custemizatian Tool: Prajectl

___\
Wi
h& SignMEl

Sigrirg Method P ot FI 2R

Lestitne abe Pk
0
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9 To sign the installation file, select Sign MSI, and complete the enabled fields. These may include:

¢ Signing Method (P12, Smartcard or HSM)
¢ Certificate Path

NOTE
Ensure that a Code Signing certificate is used when using the MSI signing feature.

¢ Provider Name
¢ Key Container Name

10 In the left column, select the Graphics tab.
The Graphics window opens.
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& SafeMet Authenticatian Client - Custemizatian Tool: Prajectl

Fle  Actons  Help
Graphecy
:"/\
:ﬁ I i Chustornization Tool is nereing on a 335 opessting system, the folowing graphics wll replace the bannes in
Ganerd Settings
11wt Costlonrazaion T ool i narrng on o S4-bd opesabng sebem, the Solowang giaghecs sl mplacs the barrsis m
bt 33 and G- SAL nstalahion.
0O
Fastunss s lisiad Ligpai buarwd Fiat AL Tooke
At Liowset it ot SAL Tocks
Upper burwres foo armesll SAC wirdows
Pocy S
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WSl Sagring
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The following graphics can be replaced:
¢ Upper Banner for SAC Tools - (Properties: Dimensions - 764X142 pixels, Horizontal/Vertical
Resolution - 96/96 dpi, Bit Depth - 24, Frame Count - 1)

¢ Lower Banner for SAC Tools - (Properties: Dimensions - 764X76 pixels, Horizontal/Vertical
Resolution - 72/72 dpi, Bit Depth - 24, Frame Count - 1)

¢ Upper Banner for small SAC windows - (Properties: Dimensions - 506X65 pixels,
Horizontal/Vertical Resolution - 96/96 dpi, Bit Depth - 32, Frame Count - 1)

NOTE
In SafeNet Authentication Client 8.3 GA, banners for SAC windows cannot be customized.

¢ Upper Banner for large SAC windows - (Properties: Dimensions - 760X65 pixels,
Horizontal/Vertical Resolution - 96/96 dpi, Bit Depth - 32, Frame Count - 1)

NOTE
In SafeNet Authentication Client 8.3 GA, banners for SAC windows cannot be customized.

NOTE

The file format for the upper and lower banner of SAC Tools must be in JPG format, and the upper banners for small
and large SAC windows must be in PNG format.

11 To change a banner, click Browse, and select the graphic file required.
12 To save the customized settings, select File > Save As, and enter a name for the project.
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NOTE
The customized settings are saved as an xml file.
By default, project folders are saved in the following location: My Documents\SafeNet\Authentication\SAC
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Generating a Customized MSI Installation File

After the appropriate features are customized, generate an installation file.

To generate a customized installation file:
1 Open the SAC Customization Tool.

See Using the SafeNet Authentication Client Customization Tool on page 41.
2 Select File > Open.

pen r? m
Lok ke I3 580 (r & ¥ (= =0
E rCustomioed_For_cur_company

M R g
Dipcumerns

€

Diaghiop

0y

My Dozuresnts

My Compuser

e niie: | W

By i Files of hype: sl o [ ] W Cancel
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3 Browse to the xm1 file in the folder of an existing project, and click Open.

NOTE
By default, project folders are saved in the following location: My Documents\SafeNet\Authentication\SAC

The saved project opens.

4 Select Actions > Generate MSI.

An information window is displayed, informing you that the MSI installation files have been
generated.

5 Click OK to close the window.
The project folder now contains two customized MSI files:

m  Afile named <Project Name>-x32-8.3.msi for 32-bit installations
m  Afile named <Project Name>-x64-8.3.msi for 64-bit installations

4. Customization / Generating a Customized MSI Installation File
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After the .msi installation file is generated, use it to install the application with its customized
properties and features.

NOTE

Ensure that all legacy eToken Properties or SafeNet Authentication Client Tools applications are closed before upgrading,
installing, or uninstalling SafeNet Authentication Client.

To install the customized application:
1 Log on as an administrator.
2 Close all applications.

3 Browse to the folder of the customized project saved in Generating a Customized MSI Installation
File on page 53.

NOTE
By default, project folders are saved in the following location: My Documents\SafeNet\Authentication\SAC
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4 Double-click the appropriate msi file:
¢ <Project Name>-x32-8.3.msi (for 32-bit installations)
¢ <Project Name>-x64-8.3.msi (for 64-bit installations)
where <pProject Name> is the name of the customized project.

The Installation Wizard runs.
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5 Follow the wizard until the installation is complete, and a confirmation message is displayed.
6 Click Finish to complete the installation.
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Human Interface Device (HID)
Tokens

SafeNet eToken 5200 HID and 7300 HID devices allow 3rd party applications (using SafeNet's SAC
PKCS#11 libraries) to communicate exclusively with the tokens. The tokens are not exposed, and
cannot be used on any other smart card application that resides on the computer. This allows limiting
the usage of a token to a specific application.

For SafeNet eToken 7300 HID devices, the 3rd party application resides on the CD Rom partition.
In this chapter:

m efToken 7300 HID
m efToken 5200 HID

5. Human Interface Device (HID) Tokens /
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The SafeNet eToken 7300-HID device is configured with PID 0x3005, and is used in environments
where no SAC installation, or driver installations are required.

The SafeNet eToken 7300 HID device is used with 3rd party applications that embed SAC PKCS#11
libraries within the application. The application can be located on the CD partition of the eToken 7300
HID device, and then run locally on the host computer, or within a browser.

Applications can communicate exclusively with the eToken 7300 HID device, provided that SAC is not
installed. All other Smart Card applications will not be able to communicate with the token.

When connecting the 7300 HID token, the following interfaces are active:
= HID

m Mass Storage (CD ROM/Flash)

When SAC is installed on a computer, the token becomes available to any PKCS#11, and MS CAPI
application, installed on the computer.

NOTE
The eToken 7300 HID device is guaranteed to work exclusively with a specific application only if SAC is not installed.

SafeNet eToken 7300 HID is not compatible with Smart Card Logon and CAPI based VPN applications.
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Using the eToken 7300 HID device on Windows

Below is an example on how to use the eToken 7300 HID device with Firefox via PKCS#11.

On a Windows operating system, reader slots must be allocated for HID devices.

In the Device Manager window, ensure that under Security Modules and Devices, reader slots named
ETOKEN HID READER are allocated.

| Secuarty Medules snd Devices [ Detains Valug Log
Genenc Crypho Seraces Al stata Logged In Ot
Seftware Secuiity Device Descrigtion ETOKEN HID READER 0 =
aBuiltin Roots Module Meswfacturer SafeMet, Inc, Change Baspwnrd
Buikin Object Token HW Version 10 Lead
ahew PRESHT1 Module FW \ersion 0
Urnaened Sict Label My Teken Linioad
Urnarned Slot Mpfacturer  Safeblet, Ins, Enable FIPS
Urearned Slot Seril Mamber  S5aaTdd5ebl2
Urnarmed Sot W Version an
Uesnarned Slot FW Werpen an
Urnaened Shot
Urraened Slot
Urnarmed Slot
My Taken

ETOKEN HID BEADER 1
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If reader slots named ETOKEN HID READER are not allocated, allocate appropriate reader slots by
adding the eToken Module into the Firefox device manager.

To add the eToken module into the firefox device manager:

1 Connect the SafeNet eToken 7300 device.
2 In the Firefox menu, select Preferences > Advanced > Certificates.
The Advanced window opens.
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&% @ w & QF

General  Tabs  Content  Applications  Privacy  Secunty  Sync  Advanced

General | Data Chiices | Netwark | Update | Certificates
When & sepser requests my personal cemificste
() Select one sutornatically (@) Ask me every time

View Certificates | Validation | Security Devices

3 Click Security Devices.
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The Device Manager window opens.

Security Modules and Devices Logln
4 MNES mtermal PECS 211 Module
Genenc Cryplo Senaces

Software Secusity Device Change Password
4Builtin Roots Module ]

Log Qut

Builtin Obgject Token

4 Click Load.
The Load PKCS#11 Device window opens.
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Enter the information for the medule you want to add.

Module Mame: | g0 RRE T TIE

Module filename: | | Browse.., |

5 Browse, and go to eToken 7300 CD Rom.
6 Click Open.
7 Select SafeNet Authentication Client > eToken.dll
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8 Click Open.
In the Load PKCS#11 Device window, the Module filename is displayed.

9 Click OK.
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In the Device Manager window, the name of the connected token is displayed in one of the reader
slots now allocated for HID devices.

Seuity Medultd and Dibnges Durtaik Walug Login
Genenc Crypeo Serices Stabus Logged in Fo
Seftware Secunty Device Deterption ETOEEN HI} READER O Loy

2Rl Roots Modsde Menufacturer  Safeblet, Inc, Change Bazrord
Buiktin Object Token W Version 1 Lowd

ablew PECSET Module FW Yerton 1]

Urnarned St Label My Teken Hyioec
Ursnarned Slot Manufacturer Safeblet, Ing, Enable FIPS
Urnpened Slot Sevigl Mambar S5aaTd Seb2
Urnamed Slat Ml Version an
Ursnarnied Slot FW Vermen an
Ursnipenad Slot
Ureprmed Slot
Uranamed Slot
By Token
ETOKEM HID BEADER 1
—
| |

An alternate way to load the PKCS#11 module is to copy the relevant files to the local machine and

then load them from there.

NOTE

Logging onto the system (Windows logon) using a smart card certificate is supported only with the 7300 standard

device. The eToken 7300 HID is not supported.
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On a Mac operating system, reader slots must be allocated for HID devices.

In the Device Manager window, ensure that under Security Modules and Devices, reader slots named
ETOKEN HID READER are allocated.

[ - ~|

(- NsN&] Device Manager
Security Modules and Devices Details Walue Log In
Buikin Object Token Stabus Mot Logged In
¥ Mew PRCSSL D Module Descripfion ETOKEW M RL
| Urramad Slot Manufactu,,. SafeMet, Ing Chamsza Faizwond
Unsarmed Sk B Version 1.0
Uamamed Shot FW Version 0.0 Load
Unnamed Shot Laksel My Token
Urramed Sk Manufactu... SafeNet, Ing
I Undarmed Sl Sirial Hu DEaA10e Enable FIPS
I Unsamed Sl HW Version 9.0
Unnamed Skt FW Version 9.0

CTOW M HID RLADR |
ETOR EM HID READER 2
ETOi EM HID READER 3

If reader slots named ETOKEN HID READER are not allocated, allocate appropriate reader slots by
adding the eToken HID module into the Firefox device manager.

To allocate reader slots for HID devices:
1 Connect the SafeNet eToken 7300 device.
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2
The Advanced window opens.

Advanced

w5 A P AQ@

Caneral  Tabi Cn:rl'l Applicaticas  Privacy  Security  Syne  Advanced

General  Data Choices  Network | Update

Frotocols

o Uze S50 3.0 o Uize TLS 1.0

Certificates
‘When @ SErver reguests my personal certificane:
Select one avtomatically (=) Ask me svery time

View Certificates Rewgcation Lists Walidatsan

Security Devices

z

3 C(lick Security Devices.
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The Device Manager window opens.

' - 5
BOO e  DeviceMatager
Security Modules and Devices. | | Details Valug =
¥ M55 Internal PECS #1101 Module
Ceneric Cryplo Services Log O
Scftware Security Davice hange Fasiwond
¥ Buihin Resti Modals
Builtin Object Token Load
Unloa
Enable FIFS
4 Click Load.

The Load PKCS#11 Device window opens.

H:NaNal Load PECS#11 Device

Entar the information for the madule you want 1o add.
Module fame: | bew PRCS011 Module |

Module flenama: Brewne

Cancel E
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5 Click Browse, and go to DEVICES > eToken 7300 > SafeNet-Authentication-Client >

Contents > MacOS > libeTokenHID.dylib.

e Choose a PRCSELL device 1o load
T
| P 2 = m i B~ B Macs i [+}
FAVORITES I ausorun.nf [ Contents . Infiy plés libeToken.dylib
1 Al My Files B Safebiet-A. ton-Client ¢ £ Macos .
= 5 Safebier-A.. tion-Client = M Piginfo libSACUL dylib
Wit Applications L Resources B sACMoenitor
] Deskiop B Safeler-A. ton-Cliens
5 Documents
ﬂ Downilpads
[ mevies
J9 Music
& Pictures
DEVICES
) Remote Disc
. Mountain Lion
Hide extension Cancal Open

6 Click Open.

In the Load PKCS#11 Device window, the Module filename is displayed.

7 Click OK.

In the Device Manager window, the name of the connected token is displayed in one of the reader

slots now allocated for HID devices.
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: a ﬁi‘_'l Device Manager

Seosivy Modules and Devices Details Walug
Builtin Object Token Status wot Logged In
¥ Mew PRCSSL D Module Description  [TOKEW vy AL
Urnsamed Sl Manufactu,, SafeMet, ing
Unsarmed Sk B Version 1.0
Unmamed Sk FW Version 0.0
Unnamed Shot Laksel My Token
Unmamaed Hlot Manufactu... Safefet. Ing
Undarmed Sl Sirial Hu DEaA10e
Unsamed Sk B Version 9.0
Unmamed Skt FW Version 9.0

ETOm M HID RLADLR |
ETOR EM HID READER 2
ETOi EM HID READER 3

Log In

Change Paswword

Load

Enable FIPS

NOTE
Close Firefox before disconnecting the token.

An alternate way to load the PKCS#11 module is to copy the relevant files to the local machine and

then load them from there.
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The SafeNet eToken 5200 HID and 5205 HID devices are configured with PID 0x3002, and are used in
environments where no SAC installation, or driver installations are required.

If SAC 8.3 is installed, the computer communicates with the token via the HID interface, and becomes
available to any PKCS#11, and MS CAPI application, installed on the computer.

Applications can communicate exclusively with the 5200 HID token, provided that SAC is not installed.
All other Smart Card applications will not be able to communicate with the token.

NOTE
The eToken 5200 HID device is guaranteed to work exclusively with a specific application only if SAC is not installed.

SafeNet eToken 5200 HID is not compatible with Smart Card Logon and CAPI based VPN applications.

The workaround for this limitation is to activate the Smart Card interface (VSR/CCID) by changing the
registry key HIDSIlots to zero. See Chapter 10: General Settings, on page 178.
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It is recommended that eToken PKI Client, BSec, and earlier versions of SafeNet Authentication Client
be upgraded to the latest version on each computer that uses a SafeNet eToken, iKey token, or
SafeNet smartcard. Local administrator rights are required to upgrade SafeNet Authentication Client.

NOTE

You must restart your computer when the upgrade procedure completes. When upgrading via the command line using the
/qn parameter, your computer is restarted automatically.

In this chapter:

= Simplified Upgrade

= Upgrading Using MSI

m  Upgrading from eToken PKI Client

m  Upgrading from SafeNet Borderless Security (BSec)

6. Upgrade /
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The simplest way to upgrade to SafeNet Authentication Client 8.3 is to use an .exe installer file. These
files do not support customization.

An .exe installer file installs SafeNet Authentication Client 8.3 properly on 32-bit and 64-bit
environments in each of the following situations:

= No middleware is yet installed

m  SafeNet Authentication Client 8.0 or later is installed, with or without BSec compatibility
m eToken PKI Client 5.1 SP1 is installed

m  BSec 7.2.0 or later is installed

NOTE

Ensure that all eToken Properties or SafeNet Authentication Client Tools applications are closed before upgrading, installing,
or uninstalling SafeNet Authentication Client.

eToken PKI Client 5.1 SP1, BSec 7.2.0 or later, and earlier versions of SafeNet Authentication Client,
are automatically upgraded during the SafeNet Authentication Client 8.3 installation.
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To run the installer:

m To upgrade from an earlier version of SafeNet Authentication Client or from eToken PKI Client 5.1
SP1 on a 32-bit or 64-bit system, run SafeNetAuthenticationClient-x32-x64-8.3.exe.

= To upgrade from BSec 7.2.0 or later on a 32-bit system, run
SafeNetAuthenticationClientPackage-8.3.exe.

After the installer file is run, SafeNet Authentication Client 8.3 is installed. No other installation or
upgrade file need be run.
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To upgrade from earlier versions of SafeNet Authentication Client using the msi file:

m  On a 32-bit system, run SafeNetAuthenticationClient-x32-8.3.msi.
m  On a 64-bit system, run SafeNetAuthenticationClient-x64-8.3.msi.

See Installing via the Wizard on page 90.

NOTE

To avoid locking or restarting your system during an upgrade, enter the following command line: msiexec /i
SafeNetAuthenticationClient-x64-8.3.msi PROP_FAKEREADER=128 /q /norestart
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Computer and user registry settings from legacy installations are not cleared when SafeNet
Authentication Client is installed.

To manage the registry settings from eToken PKI Client installations not earlier than
4.55:

1 Install SafeNet Authentication Client 8.3 using the wizard. See Installing via the Wizard on
page 90.

If computer and user registry settings from the earlier installation are detected, a Use the
existing configuration settings option appears on the Select interface language window. See
step 6 of Installing via the Wizard on page 92.

2 Do one of the following:

¢+ To maintain the registry settings from the earlier installation, select the Use the existing
configuration settings option.

¢ To clear the registry settings from the earlier installation, clear the Use the existing
configuration settings option.

3 Continue the installation.
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Upgrading from Versions Earlier than eToken PKI Client 5.1
SP1

Legacy versions of eToken PKI Client earlier than 5.1 SP1 must be uninstalled before installing SafeNet
Authentication Client 8.3.
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You can upgrade from BSec to SafeNet Authentication Client 8.3 using automatic or manual upgrade.
You must use manual upgrade in the following situations:

= Command line configuration is required
m A BSec version earlier than 7.2.0 is installed

The automatic upgrade process runs an internal Policy Migration Tool to retain your current BSec
settings, uninstalls BSec, and installs SafeNet Authentication Client with the saved BSec settings.

Automatic upgrade is supported for BSec 7.2.0 and later. For earlier versions of BSec, use the manual
upgrade process.

NOTE
Automatic upgrade does not support command line configuration.

To upgrade from BSec 7.2.0 and later to SafeNet Authentication Client 8.3:

= Run SafeNetAuthenticationClientPackage-8.3.exe.
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When upgrading manually from BSec to SafeNet Authentication Client 8.3, first run the Policy
Migration Too/to migrate BSec settings from the BSec Client or from the BSec policies created by the
AMC on the management station. A SafeNet Authentication Client registry file is created that replicates
the BSec configuration, enabling the user to use SafeNet Authentication Client with the legacy BSec
configuration.

To upgrade and manually migrate policies and registry settings:

1 Locate the policyMigrationTool.exe file in installation package’s Too1s folder.

2 Copy the policyMigrationTool.exe file to the AMC management station, or to the folder in
which you want the new registry file of BSec policies to be written.

3 From the command line, run
PolicyMigrationTool.exe [Mod [Options]]
For a description of the Mod and options parameters, see Policy Migration Tool Parameters on
page 82.
If no command line parameters are included:

¢ The BSec policies are written to a migration file named pPolicyMigrationTool.reg in the
folder from which the PolicyMigrationTool.exe Was run.

¢ The policies are set to be imported from that file to:
HKEY LOCAL MACHINE\SOFTWARE\SafeNet\Authentication\SAC.

4 Uninstall BSec.
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5 Install SafeNet Authentication Client, optionally importing the migration file created in step 3 on
page 80 to the appropriate registry keys.

For example, if the Policy Migration Too/ was run from the c:\ folder, and migration file was saved
using the default file name, run the following command:

msiexec /i SafeNetAuthenticationClient-x32-8.3.msi
PROP REG FILE="C:\PolicyMigrationTool.reg" /gb

6 If you did not include the prop REG FILE property during the installation in step 5, import the
migration file to the appropriate registry keys by double-clicking the file created in step 3 on
page 80.

7 Configure SafeNet Authentication Client as required. (See SafeNet Authentication Client Settings
on page 134.)

Ensure that the migration file of registry keys has been imported. The registry values are appended to
the subfolders of the registry location defined when the Policy Migration Too/ was run in step 3 on
page 80. To determine the registry location, see Policy Migration Tool Parameters on page 82.
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If no command line parameters are included when running policyMigrationTool .exe:

m  The BSec policies are written to a migration file named policyMigrationTool.reg in the folder
from which the PolicyMigrationTool.exe Was run.

m  The policies are set to be imported from the migration file to:
HKEY LOCAL MACHINE\SOFTWARE\SafeNet\Authentication\SAC.

Parameter

none

AMC -i [policy
client name]

Description

The Policy Migration Tool reads the BSec client database files whose location is defined in the
registry key HKEY_LOCAL_MACHINE\SOFTWARE\SafeNet\BSecClient\InstallLocation

and creates a .reg file named PolicyMigrationTool.reg

in the folder from which the Policy Migration Tool was run.

When the .reg file is included in the PROP_REG_FILE property during SafeNet Authentication
Client installation, or when the file is double-clicked, its registry keys are imported to:
HKEY_LOCAL_MACHINE\SOFTWARE\SafeNet\Authentication\SAC.

Same as option “none”, but the name of the appropriate BSec policy client configuration is defined
in the parameter.

If no policy client name is defined and there are multiple configurations, the application displays
the configuration names and prompts for a selection.

Same as option “none”, but the .reg file’s registry keys are set to be imported to:
HKEY_CURRENT_USER\SOFTWARE\SafeNet\Authentication\SAC, and not to the
HKEY_LOCAL_MACHINE registry.
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Parameter Description

-p Same as option “none”, but the registry keys are set to be imported to the registry’s Policies
section.

¢ If option “-u” is present, this is:
HKEY_CURRENT_USER\SOFTWARE\Policies\SafeNet\Authentication\SAC

¢ If option “-u” is not present, this is:
HKEY_LOCAL_MACHINE\SOFTWARE\Policies\SafeNet\Authentication\SAC

-0 [output file = Same as option “none”, but the name and path of the new .reg file is defined in the parameter.
path and
name]

Client Installation Examples
m  PolicyMigrationTool.exe -p -u -0 c:\MyBSecConfiguration.reg
Reads the client installation, and creates a file named: c:\MyBSecConfiguration.reg

The file is set to import the registry keys to:

HKEY CURRENT USER\SOFTWARE\Policies\SafeNet\Authentication\SAC

m  PolicyMigrationTool.exe AMC -i My_AMC_Configuration
Reads the My amMC configuration package, and creates a policyMigrationTool.reg file in the
folder from which the Policy Migration Tool was run.

The file is set to import the registry keys to:
HKEY LOCAL MACHINE\SOFTWARE\SafeNet\Authentication\SAC
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SafeNet Authentication Client must be installed on each computer on which a SafeNet eToken, iKey
token, or SafeNet smartcard is to be used. Local administrator rights are required to install or uninstall
SafeNet Authentication Client.

NOTE

¢ When using an MSI file to install on Windows 7, do not run the installation from the Desktop folder. To ensure a
successful installation, run the installation from another location on your computer.

¢ On Windows Vista 64-bit and on systems later than Windows 7 and Window 2008 R2, the total number of readers is
limited to 10 from among: iKey readers, €Token readers, third-party readers, and reader emulations.

¢ If Firefox is installed on your computer, the eToken module is automatically added into the Firefox security devices list,
enabling you to work with eToken devices. If Firefox is not installed then add the eToken module manually to the Firefox
security devices list. See Chapter 5: Using the eToken 7300 HID device on Windows, on page 60

To customize the user interface and the features to be installed, see Chapter 4: Customization, on
page 34.
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In this chapter:

Installation Configurations

Upgrading

Simplified Installation

Installing a Customized Application

Installing via the Wizard

Installing via the Command Line

Installing the BSec Utility Package

Configuring Root Certificate Storage for Windows Server 2008 R2
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SafeNet Authentication Client can be installed with the following configurations:

Configuration Description Installation Steps

Standard SafeNet Standard SafeNet Authentication ¢ Install SafeNet Authentication Client. When

Authentication Client Client features and user interface. using the installation wizard, select the

Installation Support for eToken and iKey tokens. Standard Configuration option.

BSec API Compatible Same as Standard SafeNet ¢ Install SafeNet Authentication Client using
Authentication Client Installation with the installation wizard, and select the BSec-
the addition of compatibility with Compatible option.
third-party applications using the BSec
APIL.
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Upgrading

If SafeNet Authentication Client, eToken PKI Client, or BSec is already installed, see Chapter 6:
Upgrade, on page 73.
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The simplest way to install SafeNet Authentication Client 8.3 is to use the .exe installer file. This
installer file does not support customization.

The .exe installer file installs SafeNet Authentication Client 8.3 properly on both 32-bit and 64-bit
systems in all of the following situations:
= No middleware is yet installed

= Any version of SafeNet Authentication Client earlier than 8.3 is installed, with or without BSec
compatibility

m eloken PKI Client 5.1 SP1 is installed

NOTE

Ensure that all legacy e7oken Properties or SafeNet Authentication Client Tools applications are closed before upgrading,
installing, or uninstalling SafeNet Authentication Client.

To run the installer on 32-bit and 64-bit systems:
= Run SafeNetAuthenticationClient-x32-x64-8.3.exe.

After the installer file is run, SafeNet Authentication Client 8.3 is installed. No other installation or
upgrade file need be run.
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Installing a Customized Application

SafeNet Authentication Client can be installed with customized properties and features.

See Chapter 4: Customization, on page 34.
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Use the SafeNet Authentication Client Installation Wizard to install the application with its default
properties and features.

The properties that can be set using the wizard are:

= Interface language: the language in which the SafeNet Authentication Client user interface is
displayed

= BSec-compatibility: support for third-party applications developed with the BSec SDK

= Destination folder: the installation library for this and all future SafeNet authentication product
applications

If an application from the SafeNet Authentication product line or an eToken legacy product was
previously installed on the computer, do not change the destination folder.

NOTE

Ensure that all legacy e7oken Properties and SafeNet Authentication Client Tools applications are closed before upgrading,
installing, or uninstalling SafeNet Authentication Client.

To install via the installation wizard:

1 Log on as an administrator.
2 Close all applications.
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3 Double-click the appropriate file:

¢ sSafeNetAuthenticationClient-x32-8.3.msi (32-bit)
¢ SafeNetAuthenticationClient-x64-8.3.msi (64-bit)

The SafeNet Authentication Client Installation Wizard opens.

g;: SafeMet Authentication Client 8.3 Sebup ‘jgiﬁll
Welcome to the SafeNet
SafeNet Authentication Client 8.3
Authentication Installation Wizard
C"ent The Setup wizsed will inslall Salefet Authentication Chent 3.3
On YOur COMmpUlter,
It is shvongly recommended thal you close all Windows
jograms befooe uring the Setup wizeed.

Ik Hesd bo confinge.

[ _owes |

4 Click Next.
The Interface Language window is displayed.
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NOTE
If configuration settings have been saved from a previous SafeNet Authentication Client installation, an

option is displayed to use the existing settings.

el
It erface Langiage =
Sadect the inferface language | gafeNet.

Selact the SaleMel Authendication Chenl 5.3 irtedace Languags:
[E nglish 3

1~ Setup has detected sasting configurstion settings.
B Usa the existing configuation sellings

< Back Mest » Cancel |

5 From the dropdown list, select the language in which the SafeNet Authentication Client screens
will appear.

6 If configuration settings are detected from a previous version, you can select Use the existing
configuration settings.
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7 Click Next.
The End-User License Agreement is displayed.

|;§ Safeset Authentication Client 8.3 Sebup | 'j]!l
License Agresment
Fleaze iead the followng kcerse sgeement castully @aﬁuﬂt
SAFEMET SOFTWARE LICENSE TERMS g

SafeNet Authentication Client
|Legal notice:

Safehet software is not soid; rather, copies of SafeMet software are

|icensed all the wany through the distnbuton channel to the end user

LINLESS vOU HAVE ANOTHER AGREEMENT DIRECTLY WITH

SAFENET THAT CONTROLS AND ALTERS YOUR USE OR

DISTRIBUTION OF THE SAFEMET SOFTWARE, THE TERMS aND

[ DNDITIGNS OF THE APPLICAELE LICE MNSE AGREEMENTS =|
| accapt the kcense sgpesment

(Lo nat accepk the kcere apeement

cBack | s | Cancel |

8 Read the license agreement, and select the option, I accept the license agreement.
9 Click Next.
The Installation Type window opens.
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|f§'- Safeset Authentication Client 8.3 Sebup =10 EI

Installation Type
Select e installation hype SafeMNet
i+ Etandard]
— Stardmd installation
H Irechade:s reess implamentation and wpe rterface for ol & Token and
= Foey lokens.

™ BSec-compatible

— Legacy BSsc-compatibls st alalion
EE! (= Irschades ress implementshon snd ubsr rteilace lor Sl & Token snd
=13 mmmwwiﬁwmmuw
ace

< Back gmt} I Carcel

10 Select one of the following:

¢ Standard: supports all eToken and iKey tokens

¢ BSec-compatible: supports all eTokens and iKey tokens, and supports third-party
applications developed with the BSec SDK

TIP
Future versions of SafeNet Authentication Client may not support BSec-compatibility.

11 Click Next.
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The Destination Folder window opens, displaying the default installation folder.

Zio1%
Destination Folder .
Saskpcd a Folcder ins which the appication vwill b inslaled SafeMet.

St vell incehand Whae fibact for S afedlel Sastheriication Chert 8.2 in e fobowing folde:
To ircsball in & ciffierent folder, chick Browse. and selsrt anothar fiolder.

Diecstination Folder
C\Progeam Files\S aleMet\Authenficstion’, Biowse I

oo [T _cwed |

12 You can click Browse to select a different destination folder, or install the SACapplication into the
default folder:
C:\Program Files\SafeNet\Authentication\

NOTE

If an application from the SafeNet Authentication line of products, or an €Token legacy product, is already installed, we
recommend that the destination folder not be changed.
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This folder will be used as the installation library for all future SafeNet Authentication applications.
13 Click Next.

The installation proceeds.

T |

Upadating System =
Fiase wait white Safedlet Authariicarion Chert 3.3 is being instabed. @ﬂﬁe”’e‘?-
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When the installation is complete, a confirmation message is displayed.

_' Safeset Authentication Client 8.3 Sebup .lEII!lI

SafoNet SafeNet Authentication Client 8.3
@leNEL —  has been successfully installed.
Authentication

Client

Chck Firish to et Setup.

14 Click Finish to complete the installation.
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Command line installation gives the administrator full control of installation properties and features.

The SafeNet Authentication Client command line installation uses the standard Windows Installer
msiexec Syntax:

m for 32-bit systems:

msiexec /1 SafeNetAuthenticationClient-x32-8.3.msi

m for 64-bit systems:

msiexec /1 SafeNetAuthenticationClient-x64-8.3.msi

NOTE

Ensure that all legacy eToken Properties or SafeNet Authentication Client Tools applications are closed before upgrading,
installing, or uninstalling SafeNet Authentication Client.

To install via the command line:

1 Log on as an administrator.
2 Close all applications.
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3 To open the Command Prompt window, do one of the following, depending on your operating
system:

¢ From the Windows taskbar, select Start > Programs > Accessories > Command
Prompt.

Right-click Command Prompt, select Run as, and set the user to administrator.

Open the Apps screen, and then swipe or scroll to the right to locate the Windows System
section heading. Under Windows System, right click Command Prompt, and select Run as
administrator.

4 Type the msiexec command with the appropriate parameters, properties, and feature settings, as
described in this chapter.

To view optional parameters for the msiexec command:

1 From the Windows taskbar, select Start > Run.
2 In the Rundialog box, enter msiexec, and click OK.
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The Windows Installer opens, displaying the available parameters and their explanations.

wmdoms Installer =

[Windous: & |nstaller, V' 300, 40007822 -

i A plion < Fequinad Parametes [Diptional Paameler]

Inshall 0 phors
</packags | /i <Product mo
Inestals o corfigures & poduct
Ja <Product mair
Administrateee ingtad - Install a product on the netw
Spudime <Product msix [/ < Translom List:] [#g <Language ID
Huhemitioes & procuct - mlo all users, W bo cuamenl u
<fuminatall | A < Product e | ProduciCodec

Ururstials the product
Diisplay Opbons
Jouasl

Oumet e, no user mberachon
fpaasive

Uratterded mode - progress bar onky
Fal ]

Sl use imbeace bevel

n-Mall

b - Basiz LI

i1 - Reduced LI

i - Full L [del st =
4| 3

Installing in Silent Mode

Installing via the command line enables the administrator to define a silent mode installation in
addition to optional property settings.
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To run the installation in silent mode with no user interface, add /qn to the end of the msiexec
command:

m  For 32-bit systems:
msiexec /i SafeNetAuthenticationClient-x32-8.3.msi /qgn

= For 64-bit systems:

msiexec /i SafeNetAuthenticationClient-x64-8.3.msi /qgn

NOTE
To display a basic installation user interface, use the /gb parameter.

During command line installation, the administrator can override the application’s default values by
including specific properties, and assigning each a value. These new values are saved in

HKEY LOCAL MACHINE\SOFTWARE\SafeNet\Authentication\SAC.

For more information, see Chapter 10: Application Properties Hierarchy, on page 173.

NOTE

The PROP_REG_FILEproperty, described on page 109, can be written to a different registry location. Its location is determined
by the parameters set when the Policy Migration Tool runs.

Properties can be set during installation only, and not during repair.
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To set properties during installation, use the following command format:

m  For 32-bit systems:
msiexec /i SafeNetAuthenticationClient-x32-8.3.msi PROPERTY=VALUE PROPERTY=VALUE
/ab

m  For 64-bit systems:
msiexec /1 SafeNetAuthenticationClient-x64-8.3.msi PROPERTY=VALUE PROPERTY=VALUE
/gb

where

B PROPERTY is the name of a configurable property, often identified by the prefix PROP_
®  VALUE is the value assigned to the property

See the Command Line Installation Properties table on page 103 for the list of properties that can be
set during installation.

Some properties are stored as registry values and can be set or modified after installation. These
properties are described in the General Settings section on page 178.

Some properties can be set during command line installation only, and cannot be modified afterward.
These properties are described in the Installation-Only Properties section on page 105.
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Example: To install the Spanish version of SafeNet Authentication
Client in a 32-bit system, with the SAC Tools Advanced Mode
setting disabled, all registry keys to be cleared automatically upon
uninstall, and all other properties assigned their default values,
type the following command:

msiexec /i SafeNetAuthenticationClient-x32-8.3.msi

ET LANG NAME=Spanish

PROP ADVANCED VIEW=0
PROP CLEAR REG=1 /gb

Property Description
ET_LANG_NAME on page 105
KSP_ENABLED on page 105
PROP_ADVANCED_VIEW on page 202
PROP_CLEAR_REG on page 107
PROP_ETOKENREADERCOUNT on page 107
PROP_EXPLORER_DEFENROL on page 224
PROP_FAKEREADER on page 107
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Property
PROP_IKEYREADERCOUNT
PROP_LICENSE_FILE
PROP_PCSCSLOTS
PROP_PQ_HISTORYSIZE
PROP_PQ_MAXAGE
PROP_PQ_MINAGE
PROP_PQ_MINLEN
PROP_PQ_MIXCHARS
PROP_PQ_WARNPERIOD
PROP_PROPAGATECACER
PROP_PROPAGATEUSERCER
PROP_REG_FILE
PROP_SINGLELOGON
PROP_SINGLELOGONTO
PROP_SOFTWARESLOTS
PROP_UPD_INFPATH
TARGETDIR
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The following properties, unless stated otherwise, can be set during command line installation only,
and cannot be modified afterwards:

ET_LANG_NAME Property

Property Name ET_LANG_NAME
Description Determines the language in which the GUI is displayed
Value Chinese / Czech / English / French (Canada) / French / German / Hungarian /

Italian / Japanese / Korean / Lithuanian / Polish / Portuguese / Romanian / Russian
/ Spanish / Thai / Traditional Chinese / Viethnamese

Note: Values that consist of two words ( 7radlitional Chinese and French (Canada)),
must be enclosed in double quotes.

Default English

KSP_ENABLED Property

NOTE
This feature can also be set using SafeNet Authentication Client Tools, Property Settings (ADM), or registry key.
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Property Name KSP_ENABLED

Description Determines if KSP is installed

Value 0 - KSP is not installed
1 - KSP is installed and used as the default cryptographic provider on Windows Vista
or higher

2 - KSP is installed but the certificate’s provider details stored on the token are used.
These are the details displayed when the certificate is selected in SAC Tools.

Default 2

PROP_CLEAR_REG Property

Property Name PROP_CLEAR_REG
Description Determines if all registry settings are automatically cleared upon uninstall
Value 1 (True) - Registry settings are cleared upon uninstall

0 (False)- Registry settings are not cleared upon uninstall

Default 0 (False)

PROP_ETOKENREADERCOUNT Property

NOTE
This feature can also be set using SafeNet Authentication Client Tools.
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Property Name PROP_ETOKENREADERCOUNT

Description Determines the number of virtual readers for physical eToken devices only. This
determines the number of eToken devices that can be connected concurrently.

Note: On Windows Vista 64-bit and on systems later than Windows 7 and Window
2008 R2, the total number of readers is limited to 10 from among: iKey readers,
eToken readers, third-party readers, and reader emulations.

Value 0 - No virtual readers installed
1 - 16 - Number of virtual readers installed

Default 2

PROP_FAKEREADER Property

Property Name PROP_FAKEREADER

Description Determines if the emulation of a smartcard reader is installed, enabling SafeNet
eToken Virtual tokens to be used with applications requiring a smartcard reader, such
as smartcard logon and VPN.

Note: On Windows Vista 64-bit and on systems later than Windows 7 and Window
2008 R2, the total number of readers is limited to 10 from among: iKey readers,
eToken readers, third-party readers, and reader emulations.

Value 1 (True) - Emulation of a smartcard reader is installed
0 (False)- Emulation of a smartcard reader is not installed

Default 1 (True)
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PROP_IKEYREADERCOUNT Property

Property Name PROP_IKEYREADERCOUNT

Description Determines the number of virtual readers for physical iKey devices only. This
determines the number of iKey devices that can be connected concurrently.

Note: On Windows Vista 64-bit and on systems later than Windows 7 and Window
2008 R2, the total number of readers is limited to 10 from among: iKey readers,
eToken readers, third-party readers, and reader emulations.

Value 0 - No virtual readers are installed
1 - 16 - Number of virtual readers installed

Default 2

PROP_LICENSE_FILE Property

Property Name PROP_LICENSE_FILE
Description Defines the location of the SAC license file
Value The path to a file containing the SafeNet Authentication Client license

Note: The full path must be used.

Default none

7. Installation / Installing via the Command Line
SAC 8.3 Build 73 - Administrator’s Guide, 007-012450-001 - Revision C, ©2014 SafeNet, Inc. O <€ 108 » M



PROP_REG_FILE Property

Property Name PROP_REG_FILE

Description Defines the BSec settings .reg file, created by the Policy Migration Tool, that is
imported to the computer’s registry folder during the installation
The default registry folder is
HKEY_LOCAL_MACHINE\SOFTWARE\SafeNet\Authentication\SAC
See Manual Upgrade of BSec Policies and Registry Settings on page 80.

Value The path to a saved registry file
Note: The full path must be used.

Default none

NOTE

While other command line installation properties set values only in
HKEY_LOCAL_MACHINE\SOFTWARE\SafeNet\Authentication\SAC, values set in the PROP_REG_FILE file are appended to
the subfolders of the registry location defined when the Policy Migration Tool/ was run.

See Manual Upgrade of BSec Policies and Registry Settings on page 80.
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PROP_UPD_INFPATH Property

Property Name PROP_UPD_INFPATH
Description Determines the update driver search path on install/uninstall
Value The update driver search path on install/uninstall
Default none
TARGETDIR Property
Property Name TARGETDIR
Description Determines which installation folder to use as the installation library for this and all

future SafeNet Authentication application installations.
Use only if there are no other SafeNet Authentication or legacy eToken applications

installed.

Value The path to the installation library

Default None - the application is installed in the default SafeNet Authentication installation
folder

NOTE

Include the TARGETDIR property only if there are no other SafeNet Authentication applications or legacy eToken applications
installed on the computer.
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To exclude specific features from the SafeNet Authentication Client installation, use the AbppEFAULT
parameter to install only those features required. The excluded features can be added afterwards to
the installed application.

To install only specific features, use the following command format:

msiexec /i SafeNetAuthenticationClient-x32-8.3.msi ADDDEFAULT=F1,F2..Fn INSTALLLEVEL=n
PROP TKEYREADERCOUNT=n /dqb

where
B SafeNetAuthenticationClient-x32-8.3 is the 32-bit SafeNet Authentication Client installation file.
For 64-bit systems, use safeNetAuthenticationClient-x64-8.3.ms1i.

m  ADDDEFAULT indicates that only the following features are included in the installation, or added to
the installed application.

m  rXx is the name of each feature to be included.

®  INSTALLLEVEL indicates the installation level, where n is:
¢ 3: standard installation (default)
¢ 5: BSec-compatible installation

®m  PROP_IKEYREADERCOUNT=n indicates the number of virtual iKey readers that are installed.
(Default is 2.)

See the table SafeNet Authentication Client Features to Add or Remove on page 117 for the list of
features that can be included during installation.
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NOTE
The number of iKey readers can be set from the command line only.

To install SafeNet Authentication Client on a 32-bit system with all features, including eToken and iKey
support, type the following command:

msiexec /i SafeNetAuthenticationClient-x32-8.3.msi /gb

To install SafeNet Authentication Client on a 32-bit system with all features except support for KSP,
type the following command:

msiexec /i SafeNetAuthenticationClient-x32-8.3.msi KSP Enabled=0 /gb
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To install SafeNet Authentication Client on a 64-bit system with five eToken readers, three iKey

readers, two SafeNet eToken Virtual readers, and no smartcard reader emulation, type the following
command:

msiexec /i SafeNetAuthenticationClient-x64-8.3.msi PROP_PCSCSLOTS=10

PROP_ETOKENREADERCOUNT=5 PROP IKEYREADERCOUNT=3 PROP SOFTWARESLOTS=2
PROP_FAKEREADER=0 /gb

NOTE

On Windows Vista 64-bit and on systems later than Windows 7 and Window 2008 R2, the total number of readers is limited
to 10 from among: iKey readers, eToken readers, third-party readers, and reader emulations.

To install SafeNet Authentication Client on a 32-bit system, without support for iKey, type the following
command:

msiexec /i SafeNetAuthenticationClient-x32-8.3.msi ADDDEFAULT=

eTokenDrivers, etFSFeature, eTokenSAPI, eTokenPKCS11l,eTokenCAPI,KSP, SACUI, SACMonitor, SAC
Service, SACTools/gb

Any of the optional features in this example can be excluded.
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To install SafeNet Authentication Client without support for eToken devices on a 32-bit system, type
the following command:

msiexec /i SafeNetAuthenticationClient-x32-8.3.msi ADDDEFAULT=

BsecDrivers, etFSFeature, eTokenSAPI, eTokenPKCS11,eTokenCAPI, SACUI, SACMonitor, SACServic
e, SACTools /gb

Any of the optional features in this example can be excluded.

To install SafeNet Authentication Client on a 32-bit system, with many standard features, but without
the SafeNet Authentication Client Tools application, type the following command:

msiexec /i SafeNetAuthenticationClient-x32-8.3.msi ADDDEFAULT=

eTokenDrivers, BsecDrivers, etFSFeature, eTokenSAPI, eTokenPKCS11l,eTokenCAPI,KSP, SACUI, SA
CMonitor, SACService /gb

To add the SafeNet Authentication Client Tools application to SafeNet Authentication Client on a 32-bit
system after installation, type the following command:

msiexec /i SafeNetAuthenticationClient-x32-8.3.msi ADDDEFAULT=SACTools /gb
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To install SafeNet Authentication Client with CAPI and PKCS#11 for both eToken and BSec on a 32-bit
system, type the following command:

msiexec /i SafeNetAuthenticationClient-x32-8.3.msi INSTALLLEVEL=5 /qgb
Where:
INSTALLLEVEL=5 indicates that the installation is BSec-compatible.

The standard interface is installed by default. For the BSec user interface, configure the BSec Ul
Compatible setting. (See Configuring Root Certificate Storage for Windows Server 2008 R2 on
page 127.)

To install the BSec Utility applications (SafeNet CIP Utility, SafeNet Token Utility, and SafeNet Token
Manager Utility) use safeNetAuthenticationClient-BSecUtilities-8.2.msi

NOTE

SafeNetAuthenticationClient-BSecUtilities-8.2.msi, which installs legacy BSec Utilities that can be used with BSec-compatible
SafeNet Authentication Client versions 8.2 and 8.3, is not packaged with SafeNet Authentication Client 8.3. It is provided in
the SafeNet Authentication Client 8.2 installation folder.

Future versions of SafeNet Authentication Client may not support BSec-compatibility.
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Installed features can be removed from the SafeNet Authentication Client installation. To remove
features, use the following format:

msiexec /x SafeNetAuthenticationClient-x32-8.3.msi REMOVE=F1,F2..,Fn /gb

where

B  SafeNetAuthenticationClient-x32-8.3.msi is the 32-bit SafeNet Authentication Client
installation file. For 64-bit systems, use safeNetAuthenticationClient-x64-8.3.msi

= REMOVE indicates that the following features are to be removed

m rXx is the name of each feature to be removed

See the table: SafeNet Authentication Client Features to Add or Remove on page 117 for the list of
features.

NOTE
Only optional features can be removed.

Example: To remove the SafeNet Authentication Client Tools
application after it was installed with SafeNet Authentication Client
on a 32-bit system, type the following command:

msiexec /x SafeNetAuthenticationClient-x32-8.3.msi
REMOVE=SACTools /gb
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SafeNet Authentication Client Features to Add or Remove

Feature Parent Feature Installs Comment
DriverFeature eTokenDrivers eToken drivers Required for €Token and iKey
physical devices.
BsecDrivers iKey token drivers
CoreFeature etFSFeature Proprietary file system API Required.

X Installs functionality for full
eTokenSAPI Proprietary supplementary API operation of SafeNet
eTokenPKCS11  Standard PKCS#11 implementation APT for  Authentication Client.

eToken and iKey tokens Can be installed without
DriverFeature (to work with
eTokenCAPI Standard CAPI implementation for eToken SafeNet eToken Virtual or
and iKey tokens; other readers).
requires the eTokenPKCS11 feature to be
included
KSP Support for the Smart Card KSP provider;
requires the eTokenCAPI feature to be
included
BsecCAPI Support for legacy iKey CAPI applications
BsecPKCS#11 Support for legacy iKey PKCS#11
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SafeNet Authentication Client Features to Add or Remove (Cont.)

Feature Parent Feature Installs ‘ Comment

SACUI SACTools User interface applications Optional, but required for
(Use both SACUI SafeNet Authentication Client
and SACTools in Tools and SafeNet

command line) Authentication Client tray icon

application features.

Services SACMonitor SafeNet Authentication Client tray icon Required.
application (Monitor) for eToken and iKey
token support

SACService SACService for eToken and iKey token
support
Extensions Identrust IdenTrust support Optional.
Installs IdenTrust software
required for iKey device
support.
Entrust SafeNet Authentication Client PKCS#11 Optional.
provider to the Entrust configuration Applicable to Entrust ESP
Clients only.
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SafeNet Authentication Client Features to Add or Remove (Cont.)

Feature Parent Feature Installs ‘ Comment
UI_BSEC x32 SafeNet SafeNet Common Utilities BSec-compatible features.
Common Utilities UI_BSEC features are
installed via
SafeNetTokenMa = SafeNet Token Manager Utility application SafeNetAuthenticationClient-
nagerUtility for iKey token support BSecUtilities-8.2.msi

SafeNetTokenUtil = SafeNet Token Utilities application for iKey
ities token support

SafeNetCIPUtiliti =~ SafeNet CIP Utilities application for iKey
es token support

NOTE

To enable SafeNet token support without installing SafeNet Authentication Client Tools, use the SafeNet Authentication Client
command line installation with eTokenDrivers and/or BsecDrivers only.
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If required, BSec-compatibility can be installed. See Installation Configurations on page 86.

There is no new release of the BSec Utility package for version 8.3. Continue to use BSec Compatibility
Utilities Package 8.2.

The BSec Utilities package includes the following components:

m SafeNet CIP Utilities
m  SafeNet Token Utilities
m SafeNet Token Manager Utility

To install the BSec Utilities package:

NOTE

SafeNetAuthenticationClient-BSecUtilities-8.2.msi, which installs legacy BSec Utilities that can be used with BSec-compatible
SafeNet Authentication Client versions 8.2 and 8.3, is not packaged with SafeNet Authentication Client 8.3. It is provided in
the SafeNet Authentication Client 8.2 installation folder.

Future versions of SafeNet Authentication Client may not support BSec-compatibility.

1 Install SafeNet Authentication Client with the BSec-compatible configuration. See Installation
Configurations on page 86.

2 In the software package provided by SafeNet, double-click safeNetAuthenticationClient-
BSecUtilities-8.2.msi.
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The BSec Compatibility Utilities Package Setup Installation Wizard opens.

Welcome to the BSec

SafeMNet Compatibility Utilities Package
Authentication 8.2 Installation Wizard
Client e e

Chck Cancel by quil te telup program, then chde any progianm:
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3 Click Next.
The End-User License Agreement window opens.
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SAFENET SOFTWARE LICENSE TERMS
SafeMet Authentication Client

Legal notice:

safeMet software is not sold; rather, coples of SafeMet software are
licensed all the way through the distribution channel to the and user.
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LONTROLS AND ALTERS YOUR USE OR DISTRIEUTION OF THE SAFEMET
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4 Select I accept the license agreement and click Next.
The Destination Folder window opens, displaying the default installation folder.
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5 Click Next.

The Select Installation Type window opens.
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6 Select the required installation type and click Next:
¢ Typical - installs SafeNet Token Manager Utility only

¢ Complete - installs all components
¢ Custom - select which components to install

The Readly to Install the Application window opens.
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7 Click Next to start the installation.

When the installation is complete, a confirmation message is displayed.
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8 Click Finish to exit the wizard.
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In most environments, no special configuration is required to store a root certificate on a token.

In a Windows Server 2008 R2 environment, the Active Directory Certificate Service registry value,
CertSvc, must be manually configured to enable a root certificate to be stored on a token. If it is not
configured properly, the following message is displayed when an attempt is made to store a root
certificate on a token:

“Could not load or verify the current CA certificate. The system cannot find the file specified.”

To configure the registry to store a root certificate on a token in Windows Server 2008 R2:

1 In the Windows Registry Editor, create a registry value named RequiredPrivileges, in the Multi-
String Value format, in the following location:

HKEY LOCAL MACHINE\SYSTEM\CurrentControlSet\Services\CertSvc

NOTE
For more information about creating and editing registry keys, see Setting Registry Keys Manually on page 175.

2 In the Registry Editor right column, right-click RequiredPrivileges, select Modify, and add the
following lines to the value data:

SeTcbPrivilege

SeIncreaseQuotaPrivilege
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SeAssignPrimaryTokenPrivilege

CertSvc is now configured to open the 7oken Logon window whenever access is required to the private
key.
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Uninstall

After SafeNet Authentication Client 8.3 has been installed, it can be uninstalled. Local administrator
rights are required to uninstall SafeNet Authentication Client.

In this chapter:
®  Uninstall Overview

®m  Uninstalling via Add or Remove Programs
= Uninstalling via the Command Line

m Clearing Legacy Registry Settings
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If iKey tokens remain connected while SafeNet Authentication Client is being uninstalled, you will be
prompted to remove the iKey tokens before uninstalling the SafeNet iKey driver.

Use the Windows Control Panel Add and Remove Programs feature to uninstall the driver.
To remove SafeNet Authentication Client, use one of the following methods:

m  Uninstalling via Add or Remove Programs on page 131
m  Uninstalling via the Command Line on page 132

NOTE

Ensure that all legacy eToken Properties and SafeNet Authentication Client Tools applications are closed before upgrading,
installing, or uninstalling SafeNet Authentication Client.

If the PROP_CLEAR_REG property was enabled when SafeNet Authentication Client was installed, all
machine and user registry settings are automatically cleared during the uninstall.

NOTE

If a DLL is in use by another application, a Files in Use message is displayed. Click Ignore to continue the uninstall, and
when the uninstall completes, restart the computer.
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To uninstall via Add or Remove Programs:

1 From the Windows taskbar, select Start > Settings > Control Panel.

2 Double-click Add or Remove Programs.

3 Select SafeNet Authentication Client 8.3, and click Remove.

4 Follow the instructions to remove the application.
If the PROP_CLEAR_REG property was not enabled during installation, a Save settings window is
displayed.

2
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5 Click Yes to save the machine and user registry settings, or No to delete them.
The uninstall process proceeds.

8. Uninstall / Uninstalling via Add or Remove Programs
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If the PROP_CLEAR_REG property is not enabled, the registry settings are retained during uninstall via
the command line.

To uninstall via the command line:

1 Log on as an administrator.

2 Close all applications.

3 From the Windows taskbar, select Start > Programs > Accessories > Command Prompt.

When running on Windows Vista, right-click Command Prompt, and select Run as. Set the user
to administrator.

4 Type the appropriate command line utility:
msiexec /x SafeNetAuthenticationClient-x32-8.3.msi (for 32-bit installations)
msiexec /x SafeNetAuthenticationClient-x32-8.3.msi (for 64-bit installations)

To uninstall in silent mode, add /qan to the end of the command.

5 When the uninstall completes, restart the computer.

8. Uninstall / Uninstalling via the Command Line
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If the registry settings set by an eToken PKI Client or SafeNet Authentication Client installation were
not cleared during the uninstall, you can clear them manually.

To clear all registry settings set by eToken PKI Client or SafeNet Authentication Client:

1 Install SafeNet Authentication Client 8.3 using the wizard. See Installing via the Wizard on
page 90.

2 If computer and user registry settings from the earlier installation are detected, a Use the
existing configuration settings option appears on the Select interface language window. See
step 6 of Installing via the Wizard on page 92.

3 Clear the Use the existing configuration settings option, and continue the installation.
4 Uninstall SafeNet Authentication Client 8.3.

8. Uninstall / Clearing Legacy Registry Settings
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SafeNet Authentication Client
Settings

SafeNet Authentication Client settings are policy settings that are stored in a Windows Administrative
Template (ADM or ADMX) file, and can be edited using Windows tools. When edited on the server, the
settings can be propagated to client computers.

In this chapter:

m  SafeNet Authentication Client Settings Overview
® Adding SafeNet Authentication Client Settings

m Editing SafeNet Authentication Client Settings

= Deploying SafeNet Authentication Client Settings

9. SafeNet Authentication Client Settings /
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Administrative Template files are used to display registry-based SafeNet Authentication Client policy
settings for editing by the administrator.

Sample Administrative Template files are provided by SafeNet in the SafeNet Authentication Client
software package.

Sample Administrative Template files provided by SafeNet:

Sample File Configuration

SAC_8_3.adm SafeNet Authentication Client settings
SAC_8_3.admx SafeNet Authentication Client settings
SAC_8_3.adml File of English strings

Use the Active Directory Group Policy Object Editor (GPO) to configure the Administrative Template
ADM and ADMX files.

When configured on a client, such as Windows XP or Vista, SafeNet Authentication Client settings
apply to the local computer only.

When configured on a server, SafeNet Authentication Client settings can be set to be propagated to
the entire domain, or to apply to the domain controllers only.

9. SafeNet Authentication Client Settings / SafeNet Authentication Client Settings Overview
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The sample Administrative Template files provided by SafeNet are configured to write registry settings
to:
HKEY LOCAL MACHINE\SOFTWARE\Policies\SafeNet\Authentication\SAC

The values in this folder have a higher priority than values in any other registry folder. See Application
Properties Hierarchy on page 173 for an explanation of the registry folders.

To write settings to a different registry folder, modify the Administrative Template file.

9. SafeNet Authentication Client Settings / SafeNet Authentication Client Settings Overview
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Add the Administrative Templates snap-in to enable you to modify the SafeNet Authentication Client
settings.

= To add the Administrative Templates to Windows Server 2003 or Windows Server 2003 R2, see
Adding an ADM file to Windows Server 2003 / R2 on page 137.

® To add the Administrative Templates to Windows Server 2008 SP1 or Windows Server 2008 R2
SP1, do one of the following:

¢ Add a standard ADM Administrative Template file. See Adding an ADM file to Windows Server
2008 / R2 on page 144.

¢ Add an XML-based ADMX Administrative Template file. See Adding an ADMX file to Windows
Server 2008 / R2 on page 150.

= To add the Administrative Templates to a client computer, see Adding an ADM file to a Client
Computer on page 151.

When configured on a server, SafeNet Authentication Client settings can be set to be propagated to
the entire domain, or to apply to the domain controllers only.

9. SafeNet Authentication Client Settings / Adding SafeNet Authentication Client Settings
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To add SafeNet Authentication Client settings:

1 From the Windows taskbar, select Start > Programs > Administrative Tools > Active
Directory Users and Computers.

The Active Directory Users and Computers window opens.

B A bepe Doy Dary Users s Corgalees

M pen Yew W Hep =l x|
=+ R@E 0 "FERE IR VaE

o el iy e § el iuiler [TPRT R
] B Gt
B i e
. ]
a3 " (e L Pt —ir gcroank fox g,
) [ Dwta Contrabird 17 atinay L Bt i e rfng
o ] Fin el gt Cawt, Publehers Seouty Group . Harbaes of this group we...
=1 R TN _EOM_ACCEES Semurity Grog .
Debasggte Lk ¢ Teaunky Groun Debnsggee LM e 8 raint
Denistedrar Sedurity Group ... DAE Sdwwreilrgors Qo
[ i abePrancy Saqiniy D DR e i ol pab
Do e Segurity Grog ... Dedrabed sdrt slor....
Dieert Corsgaien s Seauriy G M ot ptuores wred e
Deorsan Condraollers Semurity Grogp ... Al domean controlen inth...
Deoossp GuteHs Seurity GroD A choratar Qs
Dornain Lhors Sevuriky Group ... Al domein ween
e H

2 In the left pane, right-click the domain node, and select Properties.
The Properties window opens.
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3 Select the Group Policy tab.

9. SafeNet Authentication Client Settings / Adding SafeNet Authentication Client Settings
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4 Do one of the following:
¢ To propagate the settings to all clients in the domain, select Default Domain Policy.

¢+ To apply the settings to the local machine and any other domain controllers in this domain,
select Default Domain Controllers Policy.
5 Click Edit.
The Group Policy Object Ediitor opens.
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6 Under the Computer Configuration node, right-click Administrative Templates, and select

Add/Remove Templates.
The Add/Remove Templates window opens.
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7 Click Add, and browse to the appropriate ADM file.
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Sample files are included in the SafeNet Authentication Client software package provided by
SafeNet.

Policy Templabes
Loskine [ V3 dor

SEC__3edm
Sl saC_BSec_Compatbls 83 sdm

Diagkbop

My Documents

3

My Comnpuser
.
-
CTLEC N Fle e | =l | Dipen

Places S T - —

8 Select the file, and click Open.
The selected template file is displayed in the Add/Remove Templates window.
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9 C(Click Close.

In the Group Policy Object Editor window, the Settings node is added under Administrative
Templates.
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Adding an ADM file to Windows Server 2008 / R2

When configured on a server, SafeNet Authentication Client settings can be set to be propagated to
the entire domain, or to apply to the domain controllers only.

To add SafeNet Authentication Client settings:

1 From the Windows taskbar, select

2 In the Run dialog box, enter gpmc.msc, and click OK.

Start > Run.

The Group Policy Management window opens.

9. SafeNet Authentication Client Settings / Adding SafeNet Authentication Client Settings
SAC 8.3 Build 73 - Administrator’s Guide, 007-012450-001 - Revision C, ©2014 SafeNet, Inc.

J

44

4 144 » M



ol

4 Be fAcken e edew Hep =181=]
e% | c B
[ e Graup Policy Management
F A% Forest Dosusnd 2. com o L Eetcy
= | iy Crrasing I

= g3 Domardl com g I
o] et Dormain Py
= (4] Dorain Conboless
i Duefamilt Dowwesin Conirolers Frdcy
¥ o Polcy (jects
% Lo WG Pl
L Sierer SOk
% Lgh Sites
i Growp Poloy Modeling
-, ‘@noun Foloy Resits

3 Do one of the following:

¢ To propagate the settings to all clients in the domain, right-click Default Domain Policy
under the domain node.

¢ To apply the settings to the local machine and any other domain controllers in this domain,
right-click Default Domain Controllers Policy under the domain node.

4  From the dropdown menu, select Edit.
The Group Policy Management Edlitor opens.
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5 Under Computer Configuration > Policies, right-click Administrative Templates: Policy
definitions (ADMX files), and select Add/Remove Templates.

The Add/Remove Templates window opens.
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6 Click Add, and browse to the appropriate ADM file.

Sample files are included in the SafeNet Authentication Client software package provided by
SafeNet.
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7 Select the file, and click Open.
The selected template file is displayed in the Ada/Remove Templates window.
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In the Group Policy Management Editor window, the Settings node is added under
Administrative Templates: Policy definitions (ADMX files).
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Adding an ADMX file to Windows Server 2008 / R2

When using an ADMKX file, you can decide in which language to display the settings. The sample ADMX
folder provided by SafeNet includes English language adm1i files.
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To add SafeNet Authentication Client settings:

1 Copy the file sac_8 3.admx thatis included in the SafeNet Authentication Client software package
provided by SafeNet to the following location:
C:\Windows\PolicyDefinitions

2 Copy the appropriate adm1 language file (sac_8 3.adml) to a language folder in the following
location:

C:\Windows\PolicyDefinitions\

NOTE

The English language file provided by SafeNet should be written to:
C:\Windows\PolicyDefinitions\en-US

You can add ADM files to Windows XP, Vista, 7, 8, and 8.1. When configured on a client, SafeNet
Authentication Client settings apply to the local computer only.

To add SafeNet Authentication Client settings:

1 From the Windows taskbar, select Start > Run.
2 In the Run dialog box, enter gpedit.msc, and click OK.
The Local Group Policy Editor opens.
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3 Under the Computer Configuration node, right-click Administrative Templates, and select
Add/Remove Templates.

The Add/Remove Templates window opens.
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4 Click Add, and browse to the appropriate ADM file.
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Sample files are included in the SafeNet Authentication Client software package provided by

SafeNet.
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5 Select the file, and click Open.
The selected template file is displayed in the Ada/Remove Templates window.
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Add /Remove Templates
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6 Click Close.

In the Local Group Policy Editor window, the Settings node is added under Administrative
Templates > Classic Administrative Templates (ADM).

NOTE
In Windows XP, the Settings node is added under Administrative Templates.
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Each SafeNet Authentication Client Settings folder contains settings that can be configured to have
priority over the SafeNet Authentication Client application defaults.

When you edit the settings, values in the registry key are changed. For more information, see
Configuration Properties on page 170.

= To edit the policy settings on Windows Server 2003 or Windows Server 2003 R2, see Editing
Settings in Windows Server 2003 / R2 on page 156.

m To edit the policy settings on Windows Server 2008 or Windows Server 2008 R2, see Editing
Settings in Windows Server 2008 / R2 on page 165.

= To edit the policy settings on a client computer, see Ediiting Settings on a Client Computer on
page 167.

To edit SafeNet Authentication Client settings:

1 From the Windows taskbar, select Start > Programs > Administrative Tools > Active
Directory Users and Computers.

The Active Directory Users and Computers window opens.
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2 In the left pane, right-click the domain node, and select Properties.

The Properties window opens.
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3 Select the Group Policy tab.
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4 Do one of the following:
¢ To propagate the settings to all clients in the domain, select Default Domain Policy.

¢+ To apply the settings to the local machine and any other domain controllers in this domain,
select Default Domain Controllers Policy.
5 Click Edit.
The Group Policy Object Ediitor opens.
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6 In the left pane, navigate to Computer Configuration > Administrative Templates, and
select one of the SafeNet Authentication Client Settings nodes.

7 The Settings folders are displayed in the right pane.
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8 Select the settings folder to edit.

The settings are displayed in the right pane.
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9 Double-click the setting to edit.
In this example, the PCSC Slots setting is selected.
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10 Select the Explain tab for an explanation of the setting and its values.
For more information on each setting, see Chapter 10: Configuration Properties, on page 170.
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11 In the Sefting tab, select one of the following:

¢ Not Configured
No change is made to the registry for this setting

¢ Enabled
The registry is changed to indicate that the policy applies to users or computers that are
subject to this GPO

¢ Disabled
The registry is changed to indicate that the policy does not apply to users or computers that
are subject to this GPO.

NOTE
For more information on these options, see Microsoft documentation.

12 If Enabled is selected, complete the values in the box.

13 Click Previous Setting or Next Setting to progress through the settings in the same folder, or
click OK to return to the list of settings.

The registry is updated.
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Editing Settings in Windows Server 2008 / R2

To edit SafeNet Authentication Client settings:
1 From the Windows taskbar, select Start > Run.
2 In the Run dialog box, enter gpmc.msc, and click OK.
The Group Policy Management window opens.
[ Grove pobeyrsnsgement N
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| B deten pem edew tep
e i A = e

_ Group Policy Manageme
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3 Do one of the following:

¢ To propagate the settings to all clients in the domain, right-click Default Domain Policy
under the domain node.

¢+ To apply the settings to the local machine and any other domain controllers in this domain,
right-click Default Domain Controllers Policy under the domain node.

4 From the dropdown menu, select Edit.
The Group Policy Management Editor opens.
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5 In the left pane, expand Computer Configuration > Policies > Administrative Templates:
Policy definitions (ADMX files).

6 Select one of the SafeNet Authentication Client Settings nodes.
The settings are displayed in the right pane.

7 Continue from Edlting Settings in Windows Server 2003 / R2 step 8, on page 161.
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To edit SafeNet Authentication Client settings:

1 From the Windows taskbar, select Start > Run.
2 In the Run dialog box, enter gpedit.msc, and click OK.
The Local Group Policy Editor opens.
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3 In the left pane, navigate to Computer Configuration > Administrative Templates >
Classic Administrative Templates.

NOTE
In Windows XP, navigate to Administrative Templates.

4 Select one of the SafeNet Authentication Client Settings nodes.
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The settings are displayed in the right pane.
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5 Continue from Editing Settings in Windows Server 2003 / R2 step 8, on page 161.

9. SafeNet Authentication Client Settings / Ediiting SafeNet Authentication Client Settings
SAC 8.3 Build 73 - Administrator’s Guide, 007-012450-001 - Revision C, ©2014 SafeNet, Inc. O K4 168 b M



After editing the SafeNet Authentication Client settings on the server, update the registry settings on
the server and on all client computers on which SafeNet Authentication Client is installed.

To apply SafeNet Authentication Client settings:
1 From the Windows taskbar, select Start > Run.
2 In the Run dialog box, enter gpupdate, and click OK.
The registry values on the server are updated to the SafeNet Authentication Client Settings values.
3 On each client computer’s Windows taskbar, select Start > Run.
4 In the Run dialog box, enter gpupdate, and click OK.
The registry values are copied from the server to the client computer.
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Configuration Properties

SafeNet Authentication Client properties are stored on the computer as registry key values which can
be added and changed to determine SafeNet Authentication Client behavior. Depending on where a
registry key value is written, it will apply globally, or be limited to a specific user or application.

In this chapter:

Setting SafeNet Authentication Client Properties

Application Properties Hierarchy

Setting Registry Keys Manually

Defining a Per Process Property

General Settings

Token-D

License Settings

Initialization Settings

SafeNet Authentication Client Tools UI Initialization Settings

10. Configuration Properties /
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SafeNet Authentication Client Tools UI Settings

CAPI Settings

Certificate Store Settings

CNG Key Storage Provider Settings

Token Password Quality Settings

SafeNet Authentication Client Tools UI Access Control List
SafeNet Authentication Client - BSec-Compatible Settings
Security Settings

SafeNet Authentication Client Security Enhancements
IdenTrust Settings

10. Configuration Properties /
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Depending on the property, registry key values can be set using at least one of the following methods:

m  Define the property during command line installation of SafeNet Authentication Client (but not
during repair). See Installing via the Command Line on page 98.
The property name, and not the registry value name, is heeded when setting the value during
command line installation.

m  Set a value using the SafeNet Authentication Client Tools application.

See the SafeNet Authentication Client User’s Guide.
Neither the registry value name nor the property name is needed.

NOTE

Values set using the SafeNet Authentication Client Tools application are saved on a per user basis in
HKEY_CURRENT_USER, and not in HKEY_LOCAL_MACHINE.

m  Set a value using the Administrator Templates (ADM/ADMX) policy settings.
See Chapter 9: SafeNet Authentication Client Settings, on page 134.
The registry value name, and not the property name, is heeded when setting the value.

m  Manually edit the registry setting.
See Setting Registry Keys Manually on page 175.
The registry value name, and not the property hame, is heeded when setting the value.

NOTE
All properties can be manually set and edited.
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Each property can be defined in up to four registry key folders. For each property, the setting found in
the highest level of the hierarchy determines the application’s behavior.

If a property is set in a folder which requires administrator permissions, that setting overrides any
other settings for that property.

SafeNet Authentication Client uses the following hierarchy to determine the application’s behavior:

1 HKEY LOCAL MACHINE\SOFTWARE\Policies\SafeNet\Authentication\SAC
Requires administrator permissions.

2 HKEY CURRENT USER\SOFTWARE\Policies\SafeNet\Authentication\SAC
Requires administrator permissions.

3 HKEY CURRENT USER\SOFTWARE\SafeNet\Authentication\SAC
Does not require administrator permissions.

4 HKEY LOCAL MACHINE\SOFTWARE\SafeNet\Authentication\SAC
Does not require administrator permissions.

5 SafeNet Authentication Client default value
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The applications properties hierarchy has the following implications:

m  When you use the sample Administrative Template (ADM/ADMX) files supplied by SafeNet to edit
SafelNet Authentication Client Settings, the edited properties are written to:
HKEY LOCAL MACHINE\SOFTWARE\Policies\SafeNet\Authentication\SAC.

These values override values set by any other method.

m  When you set properties using SafeNet Authentication Client Tools, the edited properties are
written to: HKEY CURRENT USER\SOFTWARE\SafeNet\Authentication\SAC.

These values override values set during command line installation. Since Tools settings apply “per
user” only after the user is authenticated, the user must first log on to Windows before these
settings take effect.

®  When you set properties during command line installation, the properties (except for
PROP_REG FILE) are written to: HKEY LOCAL MACHINE\SOFTWARE\SafeNet\Authentication\SAC.

m  When you set properties manually, write them to their appropriate registry keys in any of the
registry folders listed in the Hierarchy List on page 173. Unless the properties must override other
settings, we recommend writing them to:

HKEY LOCAL MACHINE\SOFTWARE\SafeNet\Authentication\SAC.

10. Configuration Properties / Application Properties Hierarchy
SAC 8.3 Build 73 - Administrator’s Guide, 007-012450-001 - Revision C, ©2014 SafeNet, Inc. O M« 174 » W



To set a registry key value:

1
2

From the Windows taskbar, select Start > Run.
In the Run dialog box, enter regedit, and click OK.
The Registry Editor opens, displaying the registry folders tree in the left pane.

Expand the tree, and select the folder of the required registry key.

Unless the properties must override other settings, we recommend writing them to:
HKEY_LOCAL_MACHINE\SOFTWARE\SafeNet\Authentication\SAC.

If a property’s folder does not exist in the Registry Editor tree, create it.

The names and settings of the values in the registry key are displayed in the right pane.

The registry value name, and not the property hame, is used when setting the value manually.
To rename or delete a value, or to modify its data, right-click its Name.

Registry settings that are not displayed in the right pane can be added.

To add a value to the registry key, or to add a new registry key in the tree, right-click the white
space in the right pane.
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You can set properties to be limited to specific applications. To do this, open the registry key in which
the property belongs, create a registry folder within it, and assign the new folder the full name of the
process. Then define the appropriate settings within the process’s folder.

In the following example, the Single Logon feature is defined for the Internet Explorer process only. It
will not apply to any other process.

To define a per process property, such as Single Logon for IE only:

1 From the Windows taskbar, select Start > Run.
2 In the Run dialog box, enter regedit, and click OK.
The Registry Editor opens, displaying the registry folders tree in the left pane.

3 Expand the appropriate registry tree.
In this example, the tree is HKEY LOCAL MACHINE\SOFTWARE\SafeNet\Authentication\SAC\

4 Ensure that a folder exists in which the property belongs.
In this example, the property must be written to the Genera/folder.
If the Generalfolder does not exist, right-click SAC, select New > Key, and assign it the name
General.

5 Right-click the folder in which the property belongs.
In this example, right-click the General/folder.
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6 If a new registry key is required, select New > Key, and assign it the name of the process.
In this example, IEXPLORE.EXE.

7 Right-click the key in which the value belongs, and select the type of value to be assigned.
In this example, select New > DWORD value.

8 Assign the appropriate setting name and value to the new key.
In this example, assign it the name SingleLogon, and to enable the feature, set the DWORD
value to 1.
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The following settings are written to the appropriate folder’s safeNet\Authentication\SAC\General
registry key.

Description

ADM File Setting Registry Value Command Line
Single Logon Setting name: Single Registry Value Name: Property name:
Logon SingleLogon PROP_SINGLELOGON
Determines if the user’s Token
Password is requested only once Values:

for applications using MS
cryptography.
Note:

¢

Does not apply to
applications that do not use
MS cryptography.

Can be set in SafeNet
Authentication Client Tools,
but since Tools settings apply
“per user” only after the user
is authenticated, the user
must first log on to Windows,
and only the next Token

Password entry will be saved.

To force Single Logon to start
from Windows Logon, define
this setting in
HKEY_LOCAL_MACHINE
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Selected - Token Password
is requested only once
Not Selected- Token
Password is requested as
needed

Default: Not selected

Values:
Single Logon Timeout >= 0
(0 = no timeout)

Default: 0

1 (True) - Token Password
is requested only once
0 (False) - Token Password
is requested as needed

Default: 0 (False)
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Description (Cont.) ADM File Setting (Cont.) Registry Value (Cont.) Command Line
Single Logon Timeout Single Logon Timeoutis set | Registry Value Name: Property name:

in the Single Logon setting. | SingleLogonTimeout PROP_SINGLELOGON
Determines the timeout, in (See “Single Logon” entry TO
seconds, of a single logon. above.) Value: >=0
Note:

¢ Applies only when Single
Logon is True.

¢ Applies to all connected
tokens and affects all
applications using these

tokens.

Software Slots Setting name: Software
Slots

Defines the number of virtual

readers for SafeNet eToken Values: >=0

Virtual tokens. (0 = SafeNet eToken Virtual
is disabled; only physical

Note: Can be modified in tokens are enabled)

‘Reader Settings’ in SafeNet
Authentication Client Tools also. = Default: 2

On Windows Vista 64-bit and on
systems later than Windows 7
and Window 2008 R2, the total
number of readers is limited to
10 from among: iKey readers,
eToken readers, third-party
readers, and reader emulations.

10. Configuration Properties / General Settings

Default: 0 (no timeout)

Registry Value Name:
SoftwareSlots

Values: >=0

(0 = SafeNet eToken Virtual
is disabled; only physical
tokens are enabled)

Default: 2

SAC 8.3 Build 73 - Administrator’s Guide, 007-012450-001 - Revision C, ©2014 SafeNet, Inc.

J

Property name:
PROP_SOFTWARESLO
TS
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Description (Cont.)

ADM File Setting (Cont.)

Registry Value (Cont.) Command Line

PCSC Slots

Defines the total number of
PC/SC slots for all USB tokens
and smartcards.

Included in this total:

¢ the number of allocated
readers for third-party
providers

¢ the number of allocated iKey
readers, which is defined
during installation and cannot
be changed

¢ the number of allocated
readers for other SafeNet
physical tokens, which can be
modified in ‘Reader Settings’
in SafeNet Authentication
Client Tools

Note: On Windows Vista 64-bit
and on systems later than
Windows 7 and Window 2008
R2, the total number of readers,
consisting of this value and any
enabled reader emulations, is
limited to 10.
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Setting name: PCSC Slots

Values: >=0

(0 = Physical tokens are
disabled; only SafeNet
eToken Virtual is enabled)

Default: 8

Registry Value Name:
PcscSlots

Property name:
PROP_PCSCSLOTS

Values: >=0

(0 = Physical tokens are
disabled; only SafeNet
eToken Virtual is enabled)

Default: 8
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Description (Cont.)

ADM File Setting (Cont.)

Registry Value (Cont.)

Command Line

HIDSlots

Defines the total number of HID
slots for all USB HID tokens.

Legacy Manufacturer Name

Determines if 'Aladdin
Knowledge Systems Ltd.' is
written as the manufacturer
name in token and token slot
descriptions

Use for legacy compatibility only
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Setting name: HIDSlots

Values: >=0

(0 = HID tokens are
disabled)

Default: 4

Setting name: Legacy
Manufacturer Name

Values:

Selected - The legacy
manufacturer name is
written

Not selected - The new
manufacturer name is
written

Default: Not selected

Registry Value Name:
HIDSlots

Values: >=0

Default: 4

Registry Value Name:
LegacyManufacturerName
Values:

1 - The legacy manufacturer
name is written

0 - The new manufacturer
name is written

Default: 0

J

Cannot be set by
command line
installation.
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Description (Cont.)

ADM File Setting (Cont.)

Registry Value (Cont.)

Command Line

Enable Private Cache

Determines if SafeNet
Authentication Client allows the
token’s private data to be cached
Applies only to tokens that were
initialized with the private data
cache setting.

The private data is cached in per
process memory.

Note: Can be set in SafeNet
Authentication Client Tools
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Setting name: Enable
Private Cache

Values:

Selected - Private data
caching is enabled

Not selected - Private
data caching is disabled

Default: Selected

Registry Value Name:
EnablePrvCache

Values:

1 (True) - Private data
caching is enabled

0 (False) - Private data
caching is disabled

Default:1 (True)

J

Cannot be set by
command line
installation.
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Description (Cont.)

ADM File Setting (Cont.)

Registry Value (Cont.) Command Line

Tolerate X509 Attributes

Determines if
CKA_SERIAL_NUMBER,
CKA_SUBJECT, and CKA_ISSUER
attributes can differ from those
in CKA_VALUE during certificate
creation

Note:

Enable TolerantX509Attributes
when using certificates created
in a non- DER encoded binary
x.509 format.

In some versions of PKI Client,
this setting was not selected by
default.

Setting name: Tolerate
X509 Attributes

Values:

Selected - The attributes
can differ

Not selected- Check that
the values match

Default: Not selected

Registry Value Name: Cannot be set by

TolerantX509Attributes command line
installation

Values:

1 (True) - The attributes

can differ

0 (False) - Check that the
values match

Default: 0 (False)

10. Configuration Properties / General Settings
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Description (Cont.)

ADM File Setting (Cont.)

Registry Value (Cont.)

Command Line

Tolerate Find Templates

Determines if PKCS#11 tolerates
a Find function with an invalid
template, returning an empty list
instead of an error

Disconnect eToken Virtual on
Logoff

Determines if SafeNet eToken
Virtual tokens are disconnected
when the user logs off.
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Setting name: Tolerate
Find Templates

Values:

Selected - A Find function
with an invalid template is
tolerated and returns an
empty list

Not Selected - A Find
function with an invalid
template is not tolerated
and returns an error

Default: Not selected

Setting name: Disconnect
eToken Virtual on Logoff

Values:

Selected - Disconnect
eToken Virtual when
logging off

Not selected - Do not
disconnect eToken Virtual
when logging off

Default: Not selected

Registry Value Name:
TolerantFindObjects

Values:

1 (True) - A Find function
with an invalid template is
tolerated and returns an
empty list

0 (False) - A Find function
with an invalid template is
not tolerated and returns an
error

Default: 0 (False)

Registry Value Name:
EtvLogoffUnplug

Values:

1 (True) - Disconnect
eToken Virtual when logging
off

0 (False) - Do not
disconnect eToken Virtual
when logging off

Default: 0 (False)

J

Cannot be set by
command line
installation

Cannot be set by
command line
installation.
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Description (Cont.)

ADM File Setting (Cont.)

Registry Value (Cont.)

Command Line

Protect Symmetric Keys

Determines if symmetric keys
are protected

Note:

If selected, even non-sensitive
symmetric keys cannot be
extracted

Cache Marker Timeout

Determines if SAC Service
periodically inspects the cache
markers of connected tokens for
an indication that token content
has changed

Note:

If tokens were initialized as
"eToken PKI Client 3.65
compatible" in SafeNet
Authentication Client 8.0 and
later, set this value to 0 to
improve performance.
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Setting name: Protect
Symmetric Keys

Values:

Selected - Symmetric keys
cannot be extricated

Not selected - Symmetric
keys can be extricated

Default: Not selected

Setting name: Cache
Marker Timeout

Values:

Selected - Connected
tokens' cache markers are
periodically inspected

Not selected - Connected
tokens' cache markers are
never inspected

Default: Selected

Registry Value Name:
SensitiveSecret

Values:

1 - Symmetric keys cannot
be extracted

0 - Symmetric keys can be
extracted

Default: 0

Registry Value Name:
CacheMarkerTimeout

Values:

1 - Connected tokens' cache
markers are periodically
inspected

0 - Connected tokens' cache
markers are never inspected

Default: 0

J

Cannot be set by
command line
installation.

Cannot be set by
command line
installation.
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Description (Cont.)

ADM File Setting (Cont.)

Registry Value (Cont.)

Command Line

Override Non-Repudiation OIDs

Overrides SAC's list of standard
certificate OIDs that require a
high level of security

Note:

Users must log on to their
tokens whenever signing with a
certificate defined as non-
repudiation.

To avoid having to authenticate
every time a cryptographic
operation is required for
certificates containing IdenTrust
OID details, remove the OID
value from the registration key
value.
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Setting name: Override
Non-Repudiation OIDs

Value:

All OID values of non-
repudiation certificates,
separated by commas

Default: No override

Registry Value Name:

NonRepudiationOID

Value:

All OID values of non-
repudiation certificates,
separated by commas

Default: No override

J

Cannot be set by
command line
installation.
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Description (Cont.)

ADM File Setting (Cont.)

Registry Value (Cont.) Command Line

Ignore Silent Mode

Determines if the 7oken Logon
window is displayed even when
the application calls the CSP/KSP
in silent mode.
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This feature cannot be set
in the GPO Editor or MMC

Registry Value Name:
IgnoreSilentMode

Cannot be set by
command line
installation.
Values:

1 (True) - Display the

Token Logon window even

in silent mode

0 (False) - Respect silent

mode

Note:

Set to True when the
SafeNet RSA KSP must use
SHA-2 to enroll a CA private
key to a token

Default: 0 (False)
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Description (Cont.)

ADM File Setting (Cont.)

Registry Value (Cont.)

Command Line

Enable Private Cache

Determines if SafeNet
Authentication Client allows the
token’s private data to be cached
Applies only to tokens that were
initialized with the private data
cache setting.

The private data is cached in per
process memory.

Note: Can be set in SafeNet
Authentication Client Tools

Tolerate Finalize

Determines if C_Finalize can be
called by DIIMain

Note:

Define this property per process
Select this setting when using
Novell Modular Authentication
Service (NMAS) applications only
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Setting name: Enable
Private Cache

Values:

Selected - Private data
caching is enabled

Not selected - Private
data caching is disabled

Default: Selected

Setting name: Tolerate
Finalize

Values:

Selected - C_Finalize can
be called by DlIMain

Not selected - C_Finalize
cannot be called by DlIMain

Default: Not selected

Registry Value Name:

EnablePrvCache

Values:

1 (True) - Private data
caching is enabled

0 (False) - Private data
caching is disabled

Default:1 (True)

Registry Value Name:

TolerantFinalize

Values:

1 (True) - C_Finalize can

be called by DlIMain
0 (False) - C_Finalize

cannot be called by DlIMain

Default: 0 (False)

J

Cannot be set by
command line
installation.

Cannot be set by
command line
installation
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Description (Cont.)

ADM File Setting (Cont.)

Registry Value (Cont.) Command Line

TempDIR

Determines if the key sets the
temporary folder for all SAC logs
and feature folders (etoken.log,
etoken.cache, etoken.hid,
etoken.lock).

Key location:

HKLM\SOFTWARE\SafeNet\Auth
entication\SAC\General

10. Configuration Properties / General Settings

Registry Value Name:
TempDIR

Value:
A new path to the required
location.

Default: %windir%\temp
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The following settings are written to the appropriate folder’s safeNet\Authentication\SAC\SyncPin

registry key.

Description

ADM File Setting

Registry Value Command Line

Synchronize with Domain
Password

Determines if
synchronization is enabled
between the eToken
password and the domain
password.

Preserve NG OTP

Determines if NG-OTP seed
is deleted during the
initialization process.

Note: To preserve the OTP
seed, change the value to
true.

Setting name: Synchronize
with Domain Password

Values:

Name of the domain (written
without a suffix) whose
password is synchronized with
the Token Password

None - Password
synchronization is not enabled

Default: None

10. Configuration Properties / General Settings
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Registry Value Name:
Domain command line
installation.
Values:

Name of the domain (written

without a suffix) whose

password is synchronized with

the Token Password

None - Password
synchronization is not enabled

Default: None

Registry Value Name:
PreserveNGOTP

Values:

1 (True) - OTP Seed will not
be deleted when initializing

the token.

0 (False) - OTP Seed will be
deleted when initializing the
token.
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The following settings are written to the appropriate folder’s safeNet\Authentication\SAC\License

registry key.
Description ADM File Setting Registry Value Command Line
SAC License String Setting name: SAC License Registry Value Name: Name of related
String License property:
Defines the license string PROP_LICENSE_FILE
issued by SafeNet for Values: Values: contains the path to
product registration License string provided by License string provided by the license string,
SafeNet SafeNet but not the string
itself.
Default: None Default: None See
PROP_LICENSE_FILE
on page 108.

10. Configuration Properties / License Settings
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The following settings are written to the appropriate folder’'s safeNet\Authentication\SAC\INIT

registry key.

Description

ADM File Setting

Registry Value

Command
Line

Maximum Token
Password Retries

Defines the default
number of consecutive
failed logon attempts that
lock the token.

Maximum Administrator
Password Retries

Defines the default
number of consecutive
failed administrator logon
attempts that lock the
token.

Setting Name:
Maximum Token Password Retries

Values:
1-15

Default: 15

Setting name: Maximum
Administrator Password Retries

Values:
1-15

Default: 15

10. Configuration Properties / Initialization Settings
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Registry Value Name:

UserMaxRetry

Values:
1-15

Default: 15

Registry Value Name:

AdminMaxRetry

Values:
1-15

Default: 15

J

Cannot be set
by command
line installation.

Cannot be set
by command
line installation.
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Description

ADM File Setting (Cont.)

Command Line
(Cont.)

Registry Value (Cont.)

Legacy Format Version

Defines the default token
format.

Setting Name:
Legacy Format Version

Values:

0 - Tokens are formatted as
backwardly compatible to eToken PKI
Client 3.65 (CardOS tokens only)

4 - Tokens are not formatted as
backwardly compatible, and password
quality settings can be saved on the
token (CardOS tokens only)

5 - Format includes new RSA behavior
that is not controlled by key size; each
key is created in a separate directory
(CardOS 4.20B FIPS or Java Card-
based tokens only)

Default:

4, for CardOS tokens

5, for 4.20B FIPS and Java Card -
based tokens

Cannot be set
by command
line installation

Registry Value Name:
Legacy-Format-Version

Values:

0 - Tokens are formatted as
backwardly compatible to
eToken PKI Client 3.65
(CardOS tokens only)

4 - Tokens are not formatted
as backwardly compatible, and
password quality settings can
be saved on the token (CardOS
tokens only)

5 - Format includes new RSA
behavior that is not controlled
by key size; each key is
created in a separate directory
(CardOS 4.20B FIPS or Java
Card-based tokens only)

Default:

4, for CardOS tokens

5, for 4.20B FIPS and Java
Card -based tokens

10. Configuration Properties / Initialization Settings
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Description ADM File Setting (Cont.) Registry Value (Cont.) Command Line
(Cont.)
RSA-2048 Setting Name: RSA-2048 Registry Value Name: RSA- = Cannot be set

Determines if the token
support 2048-bit RSA
keys by default.

Note: Can be set in
SafeNet Authentication
Client Tools.

OTP Support

Determines if the token
supports OTP generation
by default.

This setting enables
HMAC-SHA1 support,
required by OTP tokens.

Note: Can be set in
SafeNet Authentication
Client Tools.

Values:

Selected - 2048-bit RSA keys are
supported

Not selected - 2048-bit RSA keys are
not supported

Default: Not selected

Setting Name: OTP Support

Values:

Selected - OTP generation is
supported

Not selected - OTP generation is not
supported

Default: Selected, for OTP tokens.
Not selected, for other tokens

10. Configuration Properties / Initialization Settings
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2048

Values:

1(True) - 2048-bit RSA keys

are supported

0 (False) - 2048-bit RSA keys

are not supported

Default: 0 (False)

Registry Value Name:
HMAC-SHA1

Values:

1 (True) - OTP generation is

supported

0 (False) - OTP generation is

not supported

Default: 1 (True), for OTP
tokens. 0 (False), for other

tokens

J

by command
line installation

Cannot be set
by command
line installation
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Description ADM File Setting (Cont.) Registry Value (Cont.) Command Line

(Cont.)
RSA Area Size Setting Name: RSA Area Size Registry Value Name: RSA- = Cannot be set
Area-Size by command

For CardOS-based Values: line installation.
tokens, defines the >=0 Default: depends on the
default size, in bytes, of (0 =RSA keys cannot be created on a | token size:
the area to reserve for token) ¢ For 16 K tokens, enough
RSA keys. _ bytes for three 1024-bit
# The size of the area Default: depends on the token size: keys

allocated on the token ¢ For 16 K tokens, enough bytes for ¢ For 32 K tokens, enough

is determined during three 1024-bit keys bytes for five 1024-bit keys

token initialization, and ¢ For 32 K tokens, enough bytes for 4 For larger tokens, enough

Cénn0t b'e'mo'dl'ﬁed five 1024-bit keys bytes for seven 1024-bit
without initializing the
token. 4 For larger tokens, enough bytes for keys

seven 1024-bit keys
¢ RSA-Area-Size is not

relevant when Legacy-
Format-Version is set
to 5.

Note: Can be set in
SafeNet Authentication
Client Tools.

10. Configuration Properties / Initialization Settings
SAC 8.3 Build 73 - Administrator’s Guide, 007-012450-001 - Revision C, ©2014 SafeNet, Inc. O K4 195 » W



Description ADM File Setting (Cont.) Registry Value (Cont.) Command Line

(Cont.)

Default Token Name Setting Name: Default Token Name = Registry Value Name: Cannot be set

DefaultLabel by command
Defines the default Token = Value: String line installation.
Name written to tokens Value: String
during initialization. Default: My Token

Default: My Token
API: Keep Token Settings | Setting Name: Registry Value Name: Cannot be set

API: Keep Token Settings KeepTokenInit by command

When initializing the line installation.
token using the SDK, Values: Values:
determines if the token is = Selected - Use current token settings =~ 1 (True) - Use current token
automatically re- settings
initialized with its current = Not selected - Override current 0 (False) - Override current
settings. token settings token settings
Note: If selected, this Default: Not selected Default: 0 (False)

setting overrides all other
initialization settings.

10. Configuration Properties / Initialization Settings
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Description

ADM File Setting (Cont.)

Registry Value (Cont.)

Command Line
(Cont.)

Automatic Certification

When initializing the
token using the SDK. If
the token has FIPS or
Common Criteria
certification, the token is
automatically initialized
with the original
certification.

Setting Name:
Automatic Certification

Values:
Selected - initialize the token with
the original certification

Not selected - initialize the token
without the certification

Default: initialize the token without
the certification.

10. Configuration Properties / Initialization Settings
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Registry Value Name:
Certification

Values:
1(True) - initialize the token
with the original certification.

0 (False) - initialize the token
without the certification

Default: 1 (True)

Note: Previous to SAC 8.2, the
default setting was 0 (False).
As CardOS 4.2 does not
support both FIPS and RSA-
2048, failure to take this into
account this may lead to token
initialization failure when using
PKCS#11. To prevent this,
ensure that the default is set
to False, or else ensure that
the application provides both
the required FIPS and RSA-
2048 settings.

Cannot be set
by command
line installation.
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Description

ADM File Setting (Cont.)

Registry Value (Cont.)

Command Line
(Cont.)

Enable Private Data
Caching Modification

Determines if the token’s
Private Data Caching
mode can be modified
after initialization.

Private Data Caching
Mode

If *‘Enable Private Data
Caching Modification' is
selected, determines who
has rights to modify the
token’s Private Data
Caching mode.

Setting Name:
Enable Private Data Caching
Modification

Values:
Selected -Can be modified
Not selected -Cannot be modified

Default: Not selected

Setting Name:
Private Data Caching Mode

Values:

Admin -Only the administrator has
rights

User -Only the user has rights

Default: Admin

10. Configuration Properties / Initialization Settings
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Registry Value Name:
PrvCachingModify

Values:

1 (True) - Can be modified
0 (False) - Cannot be
modified

Default: 0 (False)

Registry Value Name:
PrvCachingOwner

Values:
0 - Admin
1 - User

Default: 0 (Admin)

Cannot be set
by command
line installation.

Cannot be set
by command
line installation.
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Description ADM File Setting (Cont.) Registry Value (Cont.) Command Line
(Cont.)
API: RSA Secondary Setting Name: Registry Value Name: Cannot be set
Authentication Mode API: RSA Secondary Authentication 2ndAuthMode by command
Mode line installation.
If using an independent
API for initialization, Values: Values:
determines the default 0 - Never
behavior for protecting Never -New RSA private keys are not 1 - Prompt on application
RSA private keys on the protected with an additional request
token. password. 2 - Always prompt user
3- Always

Prompt on application request -If
the key generation application
requires key passwords to be created
for strong private key protection, new
RSA private keys must be protected
with an additional password.

If the key generation application does
not require strong private key
protection, new RSA private keys are
not protected with an additional
password.

10. Configuration Properties / Initialization Settings
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4 - Token authentication on
application request

Default: 0 -(Never)



Description ADM File Setting (Cont.) Registry Value (Cont.) Command Line
(Cont.)

Always prompt user - A prompt
appears asking if a new RSA private
key is to be protected with an
additional password.

Always - New RSA private keys must
be protected with an additional
password.

Token authentication on application
request - If the key generation
application requires key passwords to
be created for strong private key
protection, new RSA private keys are
protected with the Token Password.

Default: Never

10. Configuration Properties / Initialization Settings
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Description ADM File Setting (Cont.) Registry Value (Cont.) Command Line

(Cont.)
Enable RSA Secondary Setting Name: Registry Value Name: Cannot be set
Authentication Modified Enable RSA Secondary Authentication =~ 2ndAuthModify by command
Modified line installation.
Determines if the token’s Values:
RSA secondary Values: 1 (True) - Can modify
authentication can be 0 (False) - Cannot modify
modified after Selected -Can be modified
initialization. Default: 0 (False)

Not selected -Cannot be modified

Default: Not selected

10. Configuration Properties / Initialization Settings
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The following settings are written to the appropriate folder’s
SafeNet\Authentication\SAC\AccessControl registry key.

Description ADM File Setting Registry Value Command Line
Enable Advanced View Setting Name: Enable Registry Value Name: PROP_ADVANCED _V
Button Advanced View Button AdvancedView IEW
Determines if the Values: Values:
Advanced View icon is Selected - Enabled 1 - Selected
enabled in SAC Tools Not selected -Disabled 0 - Not selected

Default: Selected Default: 1

The following settings are written to the appropriate folder’s safeNet\Authentication\SAC\InitApp
registry key.

Description ADM File Setting Registry Value Command Line
Default Token Password Setting Name: Default Token =~ Registry Value Name: Cannot be set by
Password DefaultUserPassword command line
Defines the default Token installation.
Password Value: String Values: String
Default: 1234567890 Default: 1234567890

10. Configuration Properties / SafeNet Authentication Client Tools UI Initialization Settings
SAC 8.3 Build 73 - Administrator’s Guide, 007-012450-001 - Revision C, ©2014 SafeNet, Inc. O K< 202 » W



Description (Cont.) ADM File Setting (Cont.) Registry Value (Cont.) Command Line

Enable Change Password on  Setting Name: Enable Registry Value Name: Cannot be set by

First Logon Change Password on First MustChangePasswordEnabled | command line
Logon installation.

Determines if the “Token Values:

Password must be changed Values: 1 - Selected

on first logon” option can be = Selected - Enabled 0 - Not selected

changed by the user in the Not selected -Disabled

Token Initialization window. Default: 1

Default: Selected
Note:

This option is selected by
default. If the option is de-
selected, it can be selected
again only by setting the

registry key.

Change Password on First Setting Name: Change Registry Value Name: Cannot be set by

Logon Password on First Logon MustChangePassword command line
installation.

Determines if the 7oken Values: Value:

Password must be changed Selected 1 - Selected

on first logon option is Not selected 0 - Not selected

selected by default in the

Token Initialization window. Default: Selected Default: 1

Note:

This option is not supported

by iKey.

10. Configuration Properties / SafeNet Authentication Client Tools UI Initialization Settings
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Description (Cont.)

ADM File Setting (Cont.)

Registry Value (Cont.)

Command Line

Private Data Caching

Setting Name: Private Data

Registry Value Name:

Cannot be set by

Caching PrivateDataCaching command line
If Enable Private Cacheis installation.
selected, determines the Values: Values:
token’s private data cache Always - (fastest) private 0 - (fastest) private data is
default behavior. data is cached when used by cached when used by an
an application while the useris | application while the user is
Note: Can be set in SafeNet = l0gged on to the token, and logged on to the token, and
Authentication Client Tools. erased only when the token is | erased only when the token is
disconnected disconnected
While user is logged on - 1 - private data is cached
private data is cached when when used by an application
used by an application while while the user is logged on to
the user is logged on to the the token, and erased when
token, and erased when the the user logs off or the token
user logs off or the token is is disconnected
disconnected 2 - private data is not cached
Never - private data is not
cached Default: 0
Default: Always
10. Configuration Properties / SafeNet Authentication Client Tools UI Initialization Settings
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Description (Cont.)

ADM File Setting (Cont.)

Registry Value (Cont.)

Command Line

RSA Secondary
Authentication Mode

Defines the default behavior
for protecting RSA private
keys on the token

Note: Can be set in SafeNet
Authentication Client Tools.

Setting Name: RSA
Secondary Authentication
Mode

Values:

Never - New RSA private keys
are not protected with an
additional password.

Prompt user on application
request - If the key
generation application requires
key passwords to be created
for strong private key
protection, new RSA private
keys must be protected with
an additional password. If the
key generation application
does not require strong private
key protection, new RSA
private keys are not protected
with an additional password.
Always prompt user - A
prompt appears asking if a
new RSA private key is to be
protected with an additional
password.

Always - New RSA private
keys must be protected with
an additional password.

Registry Value Name:
RSASecondaryAuthentication
Mode

Values:

0 - Never

1 - Prompt user on
application request

2 - Always prompt user

3 - Always

4 - Token authentication on
application request

Default: 0

10. Configuration Properties / SafeNet Authentication Client Tools UI Initialization Settings
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J

Cannot be set by
command line
installation
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Description (Cont.) ADM File Setting (Cont.) Registry Value (Cont.) Command Line

RSA Secondary Token authentication on
Authentication Mode application request - If the
(continued) key generation application

requires key passwords to be
created for strong private key
protection, new RSA private
keys are protected with the
Token Password. If the key
generation application does
not require strong private key
protection, new RSA private
keys are not protected with
any password.

Default: Never

Reuse Current Token Name Setting Name: Reuse Registry Value Name: Cannot be set by
Current Token Name ReadLabelFromToken command line
Determines if the token’s installation.
current Token Name is Values: Values:
displayed as the default Selected -The current Token 1 -The current Token Name is
Token Name when the token = Name is displayed displayed
is re initialized. Not selected -The current 0 -The current Token Name is
Token Name is ignored ignored
Default: Selected Default: 1
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Description (Cont.)

ADM File Setting (Cont.)

Registry Value (Cont.)

Command Line

Maximum number of 1024-
bit RSA keys

Defines the amount of space
to reserve on the token for

Common Criteria certificates
that use 1024 -bit RSA keys.

Maximum number of 2048-
bit RSA

Setting Name: Maximum
number of 1024-bit RSA keys
Values:

0-16 certificates

Default: 0

Setting Name: Maximum
number of 2048-bit RSA

Registry Value Name:
NumOfCertificatesWith1024Ke
ys_help

Values:
0-16 certificates

Default: 0

Registry Value Name:
NumOfCertificatesWith2048Ke

Cannot be set by
command line
installation.

Cannot be set by
command line

keys keys ys_help installation.
Defines the amount of space = Values: Values:
to reserve 1-16 certificates 1-16 certificates
on the token for Common
Criteria (For example, 1 = One 2048 - = Default: 4
certificates that use 2048-bit = bit RSA key certificate
RSA keys. can be written)
Default: 4
Default Common Criteria This feature cannot be set in Registry Value Name:
Import PIN the GPO Editor or MMC DefaultCommonCriterialmport
PIN
Defines the default Common
Criteria Import PIN Values: String
Default: 1234567890
10. Configuration Properties / SafeNet Authentication Client Tools UI Initialization Settings
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The following settings are written to the appropriate folder’'s safeNet\Authentication\SAC\UI

registry key.

Description

ADM File Setting

Registry Value

Command Line

Use Default Password

Determines if the Change
Password on First Logon
process assumes the current
Token Password is the
default (defined in the
Default Token Password),
and does not prompt the
user to supply it.

Setting Name: Use Default
Password

Values:

Selected - The default Token
Password is automatically
entered in the password field

Not selected -The default
Token Password is not
automatically entered in the
password field

Default: Not selected

Registry Value Name:
UseDefaultPassword

Values:

1 (True) - The default Token
Password is automatically
entered in the password field

0 (False) -The default Token
Password is not automatically
entered in the password field

Default: o (False)

Cannot be set by
command line
installation.

10. Configuration Properties / SafeNet Authentication Client Tools UI Settings
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Description (Cont.)

ADM File Setting (Cont.)

Registry Value (Cont.)

Command Line

Password Term

Defines the term used for
the token's user password.

Note: If a language other
than English is used, ensure
that

Decimal Serial Number

Determines if the Token
Information window displays
the token serial number in
hexadecimal or in decimal
format.

Setting Name: Password
Term

Values:
Password
PIN
Passcode
Passphrase

Default: Password

Setting Name: Decimal
Serial Number

Values:
Selected -Displays the serial
number in decimal format

Not selected -Displays the
serial number in hexadecimal
format

Default: Not selected

Registry Value Name:
PasswordTerm

Values (String):
Password

PIN

Passcode
Passphrase

Default: Password

Registry Value Name:
ShowDecimalSerial

Values:
1 (True) -Displays the serial
number in decimal format

0 (False) -Displays the serial
number in hexadecimal
format

Default: 0

Cannot be set by
command line
installation.

Cannot be set by
command line
installation.

10. Configuration Properties / SafeNet Authentication Client Tools UI Settings
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Description (Cont.)

ADM File Setting (Cont.)

Registry Value (Cont.)

Command Line

Enable Tray Icon

Determines if the application
tray icon is displayed when
SafeNet Authentication Client
is started.

Enable Connection
Notification

Determines if a notification
balloon is displayed when a
token is connected or
disconnected.

Setting Name: Enable Tray
Icon

Values:
Never show
Always show

Default: Always show

Setting Name: Enable
Connection Notification

Values:
Selected - Displayed
Not selected- Not displayed

Default: Not selected

10. Configuration Properties / SafeNet Authentication Client Tools UI Settings
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Registry Value Name:

ShowInTray
Values:

0 - Never Show
1 - Always Show

Default: Always show

Registry Value Name:

ShowBalloonEvents
Values:

0 - Not Displayed
1 - Displayed

Default: 0

J

Cannot be set by
command line
installation.

Cannot be set by
command line
installation.
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Description (Cont.)

ADM File Setting (Cont.)

Registry Value (Cont.) Command Line

iKey LED On

Determines when the
connected iKey LED is on.

Note:

When working with
applications related to Citrix,
set this value to 0.

Enable Logging Control

Determines if the Enable
Loggimg | Disable Logging
button is enabled in the
Client Settings Advanced tab

Home URL

Overwrites the SafeNet
home URL in SafeNet
Authentication Client Tools

Setting Name: iKey LED On

Values:

Selected - The iKey LED is
always on when SAC Monitor
is running

Not selected -The iKey LED
is on when the token has open
connections only

Default: Selected

Setting Name: Enable
Logging Control

Values:
Selected -Enabled
Not selected -Disabled

Default: Selected

Setting Name: Home URL

Values:
Valid URL

Default: SafeNet’'s home URL

Registry Value Name:
IKeyLEDOnN

Cannot be set by
command line
installation.
Values:

1 - The iKey LED is always on

when SAC Monitor is running

0 -The iKey LED is on when

the token has open

connections only

Default:1

Registry Value Name:
AllowLogsControl

Cannot be set by
command line
installation.
Values:

1 -Enabled

0 -Disabled

Default: 1

Registry Value Name:
HomeUrl

Cannot be set by
command line
installation.
Values (String):

Valid URL

Default: SafeNet's home URL

10. Configuration Properties / SafeNet Authentication Client Tools UI Settings
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Description (Cont.)

ADM File Setting (Cont.)

Registry Value (Cont.)

Command Line

eToken Anywhere

Determines if eToken
Anywhere features are
supported

Enable Certificate Expiration
Warning

Determines if a warning
message is displayed when
certificates on the token are
about to expire.

Setting Name: eToken
Anywhere

Values:
Selected -Supported
Not selected -Not supported

Default: Selected

Setting Name: Enable
Certificate Expiration Warning

Values:
Selected - A message is
displayed

Not selected - A message is
not displayed

Default: Selected

10. Configuration Properties / SafeNet Authentication Client Tools UI Settings
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Registry Value Name:
AnywhereExtendedMode

Values:
1 -Supported
0 -Not supported

Default: 1

Registry Value Name:
CertificateExpiryAlert

Values:

1 (True) - Notify the user

0 (False) - Do not notify the
user

Default: 1 (True)

J

Cannot be set by
command line
installation.

Cannot be set by
command line
installation.
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Description (Cont.)

ADM File Setting (Cont.)

Registry Value (Cont.)

Command Line

Ignore Expired Certificates

Determines if expired
certificates are ignored, and
no warning message is
displayed for expired
certificates

Certificate Expiration
Verification Frequency

Defines the minimum
interval, in days, between
certificate expiration date
verifications

Setting Name: Ignore
Expired Certificates

Values:

Selected -Expired certificates
are ignored

Not selected- A warning
message is displayed if the
token contains expired
certificates

Default: Not selected

Setting Name: Certificate
Expiration Verification
Frequency

Values:
>0

Default:
14 days

10. Configuration Properties / SafeNet Authentication Client Tools UI Settings
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Registry Value Name:
IgnoreExpiredCertificates

Values:

1 - Expired certificates are
ignored

0 - A warhing message is
displayed if the token
contains expired certificates

Default: 0

Registry Value Name:
UpdateAlertMinInterval

Values:
>0

Default:
14 days

J

Cannot be set by
command line
installation.

Cannot be set by
command line
installation.
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Description (Cont.)

ADM File Setting (Cont.)

Registry Value (Cont.)

Command Line

Certificate Expiration
Warning Period

Defines the number of days
before a certificate's
expiration date during which
a warning message is
displayed.

Warning Message Title
Defines the title to display in

certificate expiration warning
messages

Setting Name: Certificate
Expiration Warning Period

Values:
> =0
(0 = No warning)

Default: 30 days

Setting Name: Warning
Message Title

Values:
String

Default: SafeNet
Authentication Client
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Registry Value Name:

ExpiryAlertPeriodStart
Values:

> =0

(0 = No warning)

Default: 30 days

Registry Value Name:

AlertTitle

Values:
String

Default: SafeNet
Authentication Client

J

Cannot be set by
command line
installation.

Cannot be set by
command line
installation.
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Description (Cont.)

ADM File Setting (Cont.)

Registry Value (Cont.)

Command Line

Certificate Will Expire
Warning Message

Defines the warning
message to display in a
balloon during a certificate’s
“Certificate Expiration
Warning Period.”

Certificate Expired Warning
Message

Defines the warning
message to display in a
balloon if a certificate's
expiration date has passed.

Setting Name: Certificate
Will Expire Warning Message

Values:

The message can include the
following keywords
$EXPIRY_DATE - the
certificate expiration date

$EXPIRE_IN_DAYS - the
number of days until
expiration

Default: A certificate on your
token expires in
$EXPIRE_IN_DAYS days.

Setting Name: Certificate
Expired Warning Message

Values:
String

Default: Update your token
NOWw.

Registry Value Name:
FutureAlertMessage

Values:
String

Default: A certificate on your
token expires in
$EXPIRE_IN_DAYS days.

Registry Value Name:
PastAlertMessage

Values:
String

Default: Update your token
now.

Cannot be set by
command line
installation.

Cannot be set by
command line
installation.

10. Configuration Properties / SafeNet Authentication Client Tools UI Settings

SAC 8.3 Build 73 - Administrator’s Guide, 007-012450-001 - Revision C, ©2014 SafeNet, Inc. O K € 215 » M



Description (Cont.)

ADM File Setting (Cont.)

Registry Value (Cont.)

Command Line

Warning Message Click
Action

Defines what happens when
the user clicks the message
balloon.

Detailed Message

If “Show detailed message”
is selected in “Warning
Message Click Action”
setting, defines the detailed
message to display.

Website URL

If “Open website” is
selected in the “Warning
Message Click Action”
setting, defines the URL to
display

Setting Name: Warning
Message Click Action

Values:

n No action

n Show detailed message
n Open website

Default: No action

Setting Name: Detailed
Message

Values:
String

No default
Setting Name: Website URL

Values:
Website address

No default

10. Configuration Properties / SafeNet Authentication Client Tools UI Settings
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Registry Value Name:
AlertMessageClickAction

Values:

0 - No action

1 - Show detailed message
2 - Open website

Default: 0

Registry Value Name:
ActionDetailedMessage

Values:
String

No default

Registry Value Name:
ActionWebSiteURL

Values (string):
Website address

No default

J

Cannot be set by
command line
installation.

Cannot be set by
command line
installation.

Cannot be set by
command line
installation.
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Description (Cont.) ADM File Setting (Cont.) Registry Value (Cont.) Command Line

Enable Password Expiration Setting Name: Enable Registry Value Name: Cannot be set by
Notification Password Expiration NotifyPasswordExpiration command line
Notification installation.
Determines if a pop-up Values:
message is displayed in the Values: 1 (True)- A message is
system when the Token Selected - A message is displayed
Password is about to expire. | displayed 0 (False) - A message is not
Not selected - A message is | displayed
not displayed

Default: 1 (True)
Default: Selected

Display Virtual Keyboard Setting Name: Display Registry Value Name: Cannot be set by
Virtual Keyboard VirtualKeyboardOn command line

Determines if SafeNet's installation.

keystroke-secure Virtual Values: Values:

Keyboard replaces standard Selected - Enabled 1 (True)- Virtual keyboard on

keyboard entry of password Not selected -Disabled 0 (False) - Virtual keyboard

fields in the following off

windows: Default: Disabled

¢ Token Logon Default: 0 (False)

¢ Change Password

Note:

The virtual keyboard
supports English characters
only.
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Description (Cont.) ADM File Setting (Cont.) Registry Value (Cont.) Command Line

Password Policy Instructions = Setting Name: Modify Registry Value Name: Cannot be set by
Password Policy Description PasswordPolicyInstructions command line

If not empty, defines a string installation.

that replaces the default Values: Values: String

password policy description If key does not exist, the

displayed in the Unlock and default value is used:

Change Password windows. “A secure
%REPLACE_PASSWORD_TER
M% has at least 8 characters,
and contains upper-case
letters, lower-case letters,
numerals, and special
characters (such as !, $, #,
%)."

If key exists, the value in the
key is displayed.
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CAPI Settings

NOTE
These settings apply also to the Key Storage Provider (KSP).

10. Configuration Properties /| CAPI Settings
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The following settings are written to the appropriate folder’'s safeNet\Authentication\SAC\CAPI

registry key.

Description

ADM File Setting

Registry Value

Command Line

Password Timeout

Defines the number of minutes
the CAPI-required password is
valid following the last logon
activity

Note:

¢ For iKey tokens - per token
and per process.
In addition to this registry
key, an unrelated Password
Timeout value is written to
every iKey token during
manufacture. The shorter of
these two Password
Timeoutvalues - the one on
the token and the one in
this registry key during
initialization - is applied.

¢ For Java, CardOS, €Token
Virtual tokens - no
token/process specificity.
The attribute is taken from
this registry key.

10. Configuration Properties /| CAPI Settings

Setting Name: Password
Timeout

Values:
>=0
(0= No timeout)

Default: 0

Registry Value Name:

PasswordTimeout
Values:

>=0

(0= No timeout)

Default: 0
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J

Cannot be set by
command line
installation.
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Description (Cont.)

ADM File Setting (Cont.)

Registry Value (Cont.)

Command Line

Logout Mode

Determines if the user is
prompted to enter a password
for each operation requiring
the user to be logged on.

ASCII Password

Determines if non-ASCII
characters are supported in
Token Passwords, enabling a
string containing non-ASCII
characters to be used as a
smart card logon password.
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Setting Name: Logout Mode

Values:

Selected - A password prompt
is displayed for each operation
Not selected - The user
remains logged on after the first
logon

Default: Not Selected

Setting Name: ASCII
Password

Values:

Selected - Non ASCII character
are supported

Not selected -Only ASCII
characters are supported

Default: Not selected

Registry Value Name:
LogoutMode

Values:

1 (True) - A password prompt
is displayed for each operation
0 (False)- The user remains
logged on after the first logon

Default: 0

Registry Value Name:
AsciiPassword

Values:

1 (True) - Non ASCII
character are supported

0 (False)- Non ASCII
characters are not supported

Default: O(False)

Cannot be set by
command line
installation.

Cannot be set by
command line
installation.
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Description (Cont.) ADM File Setting (Cont.) Registry Value (Cont.) Command Line

Overwrite Default Certificate Setting Name: Overwrite Registry Value Name: Cannot be set by
Default Certificate OverwriteDefaultCertificate command line
Determines if the default installation.
certificate selection can be Values: Values:
reset after being explicitly set Selected -Default certificate 1 - Default certificate can be
in legacy eToken PKI Client can be reset reset
3.65 Not selected - Default 0 - Default certificate cannot
certificate cannot be reset be reset
Default: Not selected Default: 0
Import Certificate Chain Setting Name: Import Registry Value Name: Cannot be set by
Certificate Chain ImportCertChain command line
Determines if the certificate installation.
chain is imported to the token = Values: Values:
¢ Do not import 0 - Do not import certificate
chain
¢ Import

1 - Import certificate chain
¢ User selects import behavior 2- User selects import

behavior

Default: Do not import
Default: 0
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Description (Cont.)

ADM File Setting (Cont.)

Registry Value (Cont.)

Command Line

Sign Padding On-Board

Determines if sign padding is
performed on-board supported
devices for added security.
Sign padding is supported by
Java tokens.

Note: To use this feature,
SafeNet Authentication Client
8.1 or later must be installed.
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Setting Name: Sign Padding
On-Board

Values:

¢ Not supported - Sign padding
is always performed on the
host computer

¢ Supported (backwardly
compatible) - Sign padding is
performed on-board
supported devices when
running SafeNet
Authentication Client 8.1 or
later;
Sign padding is performed on
the host computer when
running SafeNet Authentica-
tion Client versions earlier
than 8.1

4 Required - Sign padding is
always performed on-board
supported devices;

Not backwardly compatible
with SafeNet Authentication
Client versions earlier than

8.1

Default: Not supported

Registry Value Name:
SignPaddingOnBoard

Values:

0 - Not supported:

Sign padding is always
performed on the host
computer

1 - Supported:

Sign padding is performed on-
board supported devices when
running SafeNet Authentication
Client 8.1 or later;

Sign padding is performed on
the host computer when
running SafeNet Authentication
Client versions earlier than 8.1
2- Required:

Sign padding is always
performed on-board supported
devices;

Not backwardly compatible
with SafeNet Authentication
Client versions earlier than 8.1

Default: 0

Cannot be set by
command line

installation.
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The following settings are written to the appropriate folder’s
SafeNet\Authentication\SAC\CAPI\IEXPLORE.EXE registry key. They apply when using Internet
Explorer only. The values are set per process on a per machine basis.

Description ADM File Setting Registry Value Command Line

No Default Key Container Setting Name: Registry Value Name: PROP_EXPLORER_D
No Default Key Container NoDefaultkeyContainer EFENROL

Determines if the latest Default

Key Container certificate on the = Values: Values:

user's token is ignored when a = Selected - The latest 1 (True)- The latest Default

new certificate is enrolled on Default Key Container Key Container certificate on

the token. certificate on the user's the user's token is ignored
token is ignored when a when a new certificate is

This feature relates to the new certificate is enrolled enrolled on the token

scrdenrl.dll ActiveX control on the token 0 (False) - The latest Default

used by the Microsoft CA web Not selected - The latest Key Container certificate on

site and the SafeNet Default Key Container the user's token is deleted

Authentication Manager. certificate on the user's when a new certificate is

Note: If the "Enrollment on token is deleted when a enrolled on the token

Behalf" certificate used for new certificate is enrolled

enrollment is stored on an on the token Default: 1 (True), for the

administrator token and not on IEXPLORE.EXE process only

a computer, this value must be ~ Default: Selected, for the

0. IEXPLORE.EXE process only
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Description (Cont.)

ADM File Setting (Cont.)

Registry Value (Cont.)

Command Line

Default Enroliment Type

Determines if the administrator
token's latest Enrollment Agent
certificate must be the

certificate used to enroll a new
certificate on the user's token.

This feature applies when

"Enroliment on Behalf" uses a
certificate on an administrator
token and not on a computer.

Note: To enable the token con-
taining the "Enrollment on
Behalf" certificate to contain
Smartcard Logon certificates
also, this value must be 1.

10. Configuration Properties /| CAPI Settings
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This feature cannot be set
in the GPO Editor or MMC

Registry Value Name:
DefEnrollType

Values:

1 (True) - The administrator
token's latest Enrollment
Agent certificate is used, even
if the token's Default Key
Container contains a different
type of certificate, such as
Smartcard Logon

0 (False) - Regardless of its
certificate type, the
administrator token's Default
Key Container certificate is
used

Default: 0 (False), for the
IEXPLORE.EXE process only

J

Cannot be set by
command line
installation, so must
be added manually
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Microsoft Certificate Propagation Service

Windows Vista and later include the Microsoft Certificate Propagation Service. This
duplicates some of the features of the SafeNet Authentication Client propagation
functionality. To avoid a lack of synchronization between these different
propagation processes, we strongly recommend closing the Microsoft Certificate
Propagation Service and using only SafeNet Authentication Client for certificate
propagation.

The following settings are written to the appropriate folder’s
SafeNet\Authentication\SAC\CertStore registry key.

Description ADM File Setting Registry Value Command Line

Propagate User Certificates Setting Name: Propagate Registry Value Name: PROP_PROPAGATEU
User Certificates PropagateUserCertificates SERCER

Determines if all user Values:

certificates on the token are ~ Values: 1 (True) - User certificates are

exported to the user Selected -User certificates exported

store. are exported 0 (False) - User certificates
Not selected - User are not exported

Note: Can be set in SafeNet ~ Certificates are not exported

Authentication Client Tools. Default: 1 (True)

Default: Selected

10. Configuration Properties / Certificate Store Settings 3
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Description (Cont.)

ADM File Setting (Cont.)

Registry Value (Cont.)

Command Line

Propagate CA Certificates

Determines if all CA
certificates on the token are
exported to the Trusted CA
store.

Note: Can be set in SafeNet
Authentication Client Tools.

Synchronize Store

Determines if store
synchronization is enabled.

The synchronize store is part
of the SAC Monitor
application. It synchronizes
between the contents of the
token and the SAC
application. For example, if
so configured, when the
token is connected the token
certificate is propagated to
the certificate store, and
removed when the token is
disconnected.

Setting Name: Propagate CA
Certificates

Values:

Selected - CA certificates are
exported

Not selected - CA certificates
are not exported

Default: Selected

Setting Name: Synchronize
Store

Values:
Selected -Enabled
Not selected -Disabled

Default: Selected

Registry Value Name:
PropagateCACertificates

Values:

1 (True)- CA certificates are
exported

0 (False)- CA certificates are
not exported

Default: 1 (True)

Registry Value Name:
SynchronizeStore

Values:
1 (True)-Enabled
0 (False) -Disabled

Default: 1 (True)

PROP_PROPAGATEC
ACER

Cannot be set by
command line
installation.

10. Configuration Properties / Certificate Store Settings
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Description (Cont.)

ADM File Setting (Cont.)

Registry Value (Cont.)

Command Line

Add New Certificates to
Token

When a certificate with
exportable keys is added to
the user store, determines if
an option is displayed to
import that certificate to the
selected token.

Remove User Certificates
upon Token Disconnect

Setting Name: Add New
Certificates to Token

Values:

Selected - An option is
displayed to import the new
certificate

Not selected - An option is
not displayed to import the
new certificate

Default: Selected

Setting Name: Remove User
Certificates upon Token

Registry Value Name:
AddToTokenOnNewCertInStore

Values:

1 (True) - An option is
displayed to import the new
certificate

0 (False) - An option is not
displayed to import the new
certificate

Default: 1 (True)

Registry Value Name:
RemoveUserCertsOnTokenRem

Cannot be set by
command line
installation.

Cannot be set by
command line

Disconnect ove installation.
When a token is
disconnected, determines if Values: Values:
the user certificates that Selected - User certificates 1 (True) - User certificates are
were exported from it are are removed from the user removed from the user store
removed from the user store 0 (False) - User certificates
store. Not selected - User are not removed from the user
certificates are not removed store
from the user store
Default: 1 (True)
Default: Selected
10. Configuration Properties / Certificate Store Settings
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Description (Cont.) ADM File Setting (Cont.) Registry Value (Cont.) Command Line

Cannot be set by
command line

Remove Certificates from
Store upon Token Disconnect

Setting Name: Remove
Certificates upon Removal

Registry Value Name:
RemoveFromStoreOnRemoveFr

SAC 8.3 Build 73 - Administrator’s Guide, 007-012450-001 - Revision C, ©2014 SafeNet, Inc.

from Token omToken installation.
When an exported certificate
is removed from the token, Values: Values:
determines if that certificate =~ Selected - The certificate is 1 (True) - The certificate is
is removed from the user removed from the user store removed from the user store
store. Not selected - The certificate = 0 (False) - The certificate is
is not removed from the user not removed from the user
store store
Default: Selected Default: 1 (True)
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Description (Cont.)

ADM File Setting (Cont.)

Registry Value (Cont.) Command Line

Remove Certificates from
Token upon Removal from
Store

When an exported certificate
is removed from the user
store, determines if an
option is displayed to
remove that certificate from
the token.

Setting Name:

Remove Certificates from
Token upon Removal from
Store

Values:

Never - an option is not
displayed to remove the
certificate

Always - an option is displayed
to remove the certificate
Template dependent - an
option is displayed to remove
only those certificates whose
templates are listed in
“Certificate Templates to
Remove from Token” setting.

Default: Never

10. Configuration Properties / Certificate Store Settings
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Registry Value Name:

RemoveFromTokenOnRemoveF = command line

romStore installation.
Values:
0 - Never; an option is not
displayed to remove the
certificate
1 - Always; an option is
displayed to remove the
certificate
2 - An option is displayed to
remove only those certificates
whose templates are listed in
the registry setting
RemoveFromStoreOnRemoveFr
omToken Templates.
Default: 0
M4 € 230

Cannot be set by

> M



Description (Cont.)

ADM File Setting (Cont.)

Registry Value (Cont.)

Command Line

Certificate Templates to
Remove from Token

Lists templates of the
certificates that can be
removed from a token when
the exported certificates are
removed from the user
store.

Setting Name: Certificate
Templates to Remove from
Token

Values:
Template names, separated by
commas

Default: None

Applies only when the Remove
Certificates from Token upon
Removal from Store setting is
set to Template dependent.

10. Configuration Properties / Certificate Store Settings
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Registry Value Name:
RemoveFromTokenOnRemoveF
romStoreTemplates

Values:
Template names, separated by
commas

Default: None

Applies only when the registry
setting
RemoveFromTokenOnRemoveF
romStore is set to 2.

Cannot be set by
command line
installation.
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Description (Cont.)

ADM File Setting (Cont.)

Registry Value (Cont.)

Command Line

Certificate Removal Period

When an exported certificate
is removed from the user
store, defines the number of
days to attempt to remove
that certificate from a token
that is not connected

Relevant only when the
setting Remove Certificates
from Token upon Removal
from Store
(RemoveFromTokenOnRemo
veFromStore)is set to
Always or Template
dependent.

Delete Original Key After
Copy

When a key and its
certificate are copied from
the certificate store to a
token, determines if the
private key is deleted from
the source CSP.

Setting Name: Certificate
Removal Period

Values:
>=0

Default:
7

Setting Name: Delete
Original Key After Copy

Values:

Selected - Key is deleted
from the CSP

Not selected - Key is
retained in the CSP

Default: Selected

10. Configuration Properties / Certificate Store Settings
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Registry Value Name:
CertsToRemoveStorePeriod

Values:
>=0

Default:
7

Registry Value Name:
DeleteOriginalKeyAfterCopy

Values:

1 (True) - Key is deleted from

the CSP
0 (False) - Key is retained in
the CSP

Default: 1 (True)

J

Cannot be set by
command line
installation.

Cannot be set by
command line
installation.
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Description (Cont.)

ADM File Setting (Cont.)

Registry Value (Cont.) Command Line

Import CA Certificates Chain

When SAC Tools imports a
user certificate from a
P12/PFX file, determines if
the CA chain is also imported
to the token.

Setting Name: Import CA
Certificates Chain

Values:

Selected - CA chain is
imported to the token

Not selected - CA chain is
not imported

Default: Selected

10. Configuration Properties / Certificate Store Settings
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Registry Value Name:
ImportUserCertCAChain

Cannot be set by
command line
installation.
Values:

1 (True) - CA chain is

imported to the token

0 (False) - CA chain is not

imported

Default: 1 (True)
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NOTE

These settings apply to the Key Storage Provider (KSP) only.

The following settings are written to the appropriate folder’s safeNet\Authentication\SAC\CNG

registry key.

Description

Cryptographic Provider

Determines which
cryptographic provider to use
for certificate propagation.

Note: Can be set in SafeNet
Authentication Client Tools.

Note: After changing the
cryptographic provider
setting, reconnect the token
to ensure that the properties
are updated to the token.

Settings in GPO Editor or
MMC

Setting Name:
Cryptographic Provider

Values:

0=CsP

1 = KSP (if supported by
the OS)

2 = The Provider that
enrolled the certificate
(This information is
stored on the token)

Default: 2

10. Configuration Properties /| CNG Key Storage Provider Settings
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Registry Key

Registry Value Name:
KspPropagationMode

Values:

0=CsP

1 = KSP (if supported by
the OS)

2 = The Provider that
enrolled the certificate
(This information is stored
on the token)

Default: 2

Command Line

KSP_ENABLED

Enables you to prevent KSP
from being installed.

See KSP_ENABLED on
page 106.
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The following settings are written to the appropriate folder’'s safeNet\Authentication\SAC\PQ

registry key.

Description Settings in GPO Editor or  Registry Key Command Line
MMC

Password - Minimum Length | Setting Name: Registry Key Name: PROP_PQ_MINLEN
Password -Minimum pgMinLen

Defines the minimum Length

password length. Values:

Note: Can be set in SafeNet =~ Values: >=4

Authentication Client Tools. >=4

Default: 6

Default: 6

Password - Maximum Length | Setting Name: Registry Key Name: Cannot be set by
Password -Maximum pgMaxLen command line installation.

Defines the maximum Length

password length. Values:

Note: Can be set in SafeNet
Authentication Client Tools.

Values:

Cannot be less than the
Password Minimum
Length

Default: 16

10. Configuration Properties / 7oken Password Quality Settings
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Cannot be less than the
Password Minimum Length

Default: 16
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Description (Cont.)

Settings in GPO Editor or
MMC (Cont.)

Registry Key (Cont.)

Command Line (Cont.)

Password - Maximum Usage
Period

Defines the maximum
number of days a password
is valid.

Note: Can be set in SafeNet
Authentication Client Tools.

Password - Minimum Usage
Period

Defines the minimum
number of days between
password changes.

Note: Can be set in SafeNet
Authentication Client Tools.

Note: Does not apply to
iKey devices.

Setting Name:
Password -Maximum
Usage Period

Values:
>=0
(0 =No expiration)

Default: 0

Setting Name:
Password - Minimum
Usage Period

Values:
>=0
(0 = No minimum)

Default: 0
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Registry Key Name:
pgMaxAge

Values:

>=0

(0 =No expiration)
Default: 0

Registry Key Name:
pgMinAge

Values:

>=0

(0 = No minimum)

Default: 0

J

PROP_PQ_MAXAGE

PROP_PQ_MINAGE
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Description (Cont.)

Settings in GPO Editor or
MMC (Cont.)

Registry Key (Cont.)

Command Line (Cont.)

Password - Expiration
Warning Period

Defines the number of days
before expiration during
which a warning is
displayed.

Note: Can be set in SafeNet
Authentication Client Tools.

Password - History Size

Defines the number of
recent passwords that must
not be repeated.

Note: Can be set in SafeNet
Authentication Client Tools.

Setting Name:
Password - Expiration
Warning Period

Values:
>=0
(0 = No warning)

Default: 0

Setting Name:
Password - History Size

Values:
>=0
(0 = No minimum)

Default: 10
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Registry Key Name:
pgqWarnPeriod

Values:
>=0
(0 = No warning)

Default: 0

Registry Key Name:
pgHistorySize

Values:
>=0
(0 = No minimum)

Default: 10
(iKey device history is limited
to 6)

PROP_PQ_WARNPERIOD

PROP_PQ_HISTORYSIZE
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Description (Cont.) Settings in GPO Editor or  Registry Key (Cont.) Command Line (Cont.)

MMC (Cont.)

Password - Maximum Setting Name: Registry Key Name: Cannot be set by

Consecutive Repetitions Password - Maximum pgMaxRepeated command line installation.
Consecutive Repetitions

Defines the maximum Values:

number of consecutive times =~ Values: 0-16

a character can beusedina 0-16 (0 = No maximum)

password. (0 = No maximum)

Note: Can be set in SafeNet Default: 3

Authentication Client Tools. Default: 3

Note: Does not apply to
iKey devices.
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Description (Cont.)

Settings in GPO Editor or
MMC (Cont.)

Registry Key (Cont.)

Command Line (Cont.)

Password - Complexity

Determines if there is a
minimum number of
character types that must be
included in a new Token
Password

The character types are:
upper-case letters, lower-
case letters, numerals, and
special characters.

Note: Can be set in SafeNet
Authentication Client Tools.

Setting Name:
Password - Complexity

Values:

Standard complexity -
A minimum of 2 or 3
types must be included,
as defined in the
Password- Minimum
Mixed Character Types
setting

Manual complexity -
The rule for each
character type is defined
in the character type's
Include setting

Default: Standard
complexity
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Registry Key Name:
pgMixChars

Values:

1 - A minimum of 2 or 3 types
must be included, as defined
in the Password- Minimum
Mixed Character Types setting
0 -The rule for each character
type is defined in the
character type's Jnclude
setting

Default: 1

J

PROP_PQ_MIXCHARS

4 € 239 » M



Description (Cont.)

Settings in GPO Editor or
MMC (Cont.)

Registry Key (Cont.)

Command Line (Cont.)

Password - Minimum Mixed
Character Types

Defines the minimum
number of character types
that must be included in a
new Token Password.

The character types are:
upper-case letters, lower-
case letters, numerals, and
special characters.

Note:

¢ Applies only when the
Password - Complexity
setting is set to
Standard complexity.

¢ Can be set in SafeNet
Authentication Client
Tools.

Setting Name:
Password - Minimum
Mixed Character Types

Values:
At least 3 character

types
At least 2 character

types

Default: At least 3
character types
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Registry Key Name:
pgMixLevel

Values:

0 - At least 3 character types
1 - At least 2 character types

Default:0

J

Cannot be set by
command line installation
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Description (Cont.) Settings in GPO Editor or = Registry Key (Cont.) Command Line (Cont.)

MMC (Cont.)
Password - Include Numerals = Setting Name: Registry Key Name: Cannot be set by
Password - Include pgNumbers command line installation
Determines if the password Numerals
can include numerals. Values:
Values: 0 -Permitted
Note: Permitted 1 - Forbidden
+ Applies only when the Forbidden 2 - Mandatory
. Mandatory
Password - Complexity .
ting is set to M I Default: 0
Setting Is set to Manua Default: Permitted
complexity. Not
¢ Can be set in SafeNet ° e.. )
Authentication Client Forbiaden is not
Tools. supported by iKey
devices.
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Description (Cont.) Settings in GPO Editor or = Registry Key (Cont.) Command Line (Cont.)

MMC (Cont.)

Password - Include Upper- Setting Name: Registry Key Name: Cannot be set by

Case Password - Include pqUpperCase command line installation.
Upper-Case

Determines if the password Values:

can include upper-case Values:

letters. Permitted 0 - Permitted
Forbidden 1 - Forbidden

Note: Mandatory 2 - Mandatory

¢ Applies only when the Default: Permitted Default: 0

Password - Complexity
setting is set to Manual
complexity.

¢ Can be set in SafeNet
Authentication Client
Tools.
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Description (Cont.) Settings in GPO Editor or = Registry Key (Cont.) Command Line (Cont.)

MMC (Cont.)

Password - Include Lower- Setting Name: Registry Key Name: Cannot be set by

Case Password - Include pgLowerCase command line installation.
Lower - Case

Determines if the password Values:

can include lower-case Values: 0 - Permitted

letters. Permitted 1 - Forbidden
Forbidden 2 - Mandatory

Note: Mandatory

¢ Applies only when the Default: 0

Password - Complexity
setting is set to Manual
complexity.

¢ Can be set in SafeNet
Authentication Client
Tools.

Default: Permitted
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Description (Cont.) Settings in GPO Editor or = Registry Key (Cont.) Command Line (Cont.)

MMC (Cont.)

Password - Include Special Setting Name: Registry Key Name: Cannot be set by

Characters Password - Include pqSpecial command line installation.
Special Characters

Determines if the password Values:

can include special Values: 0 - Permitted

characters, such as @,!, &. Permitted 1 - Forbidden

Note: Forbidden 2 - Mandatory

. Mandatory
¢ Applies only when the Default: 0

Password - Complexity
setting is set to Manual
complexity.

¢ Can be set in SafeNet
Authentication Client
Tools.

Default: Permitted
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Description (Cont.) Settings in GPO Editor or  Registry Key (Cont.) Command Line (Cont.)

MMC (Cont.)
Password Quality Check on Setting Name: Registry Key Name: Cannot be set by
Initialization Password Quality Check pqCheckInit command line installation.
on Initialization
Determines if the password Values:
quality settings are checked @ Values: 1 (True) -The password
and enforced Selected -The password = quality is enforced
when a token is initialized quality is enforced 0 (False) - The password
Not selected - The quality is not enforced
Note: password quality is not
enforced Default: 0

We recommend that this
policy not be set when
tokens are enrolled using
TMS or SafeNet
Authentication Manager.

Default: Not selected
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Description (Cont.)

Settings in GPO Editor or
MMC (Cont.)

Registry Key (Cont.)

Command Line (Cont.)

Password Quality Owner

Defines the owner of the
password quality settings on
a re initialized token, and
defines the default of the
Password Quality Modifiable
setting.

Setting Name:
Password Quality Owner

Values:
Administrator
User

Default:

Administrator, for tokens
with an Administrator
Password.

User, for tokens without
an Administrator
Password.
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Registry Key Name:
pgOwner

Values:
0 - Administrator
1 - User

Default:

0, for tokens with an
Administrator Password.
1, for tokens without an
Administrator Password.

J

Cannot be set by
command line installation.
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Description (Cont.)

Settings in GPO Editor or
MMC (Cont.)

Registry Key (Cont.) Command Line (Cont.)

Enable Password Quality
Modification

Determines if the password
quality settings on a newly
initialized token

can be modified by the
owner.

See the Password Quality
Owner setting.

Setting Name: Enable
Password Quality
Modification.

Values:

Selected - The
password quality can be
modified by the owner
Not selected - The
password quality cannot
be modified by the
owner

Default:

Selected, for
administrator-owned
tokens

Not selected, for user
owned tokens.

10. Configuration Properties / 7oken Password Quality Settings

SAC 8.3 Build 73 - Administrator’s Guide, 007-012450-001 - Revision C, ©2014 SafeNet, Inc.

Cannot be set by
command line installation.

Registry Key Name:
pqModifiable

Values:

1 (True)- The password
quality can be modified by
the owner

0 (False) - The password
quality cannot be modified by
the owner

Default:

1 (True), for administrator-
owned tokens

0 (False), for user owned
tokens.
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SafeNet Authentication Client Tools UI Access Control List

The Access Control Properties window contains a list of settings that determine which features are
enabled in the SafeNet Authentication Client Tools and Tray Menu.

hccess Control Properties I F
Seting | Exgiain |

W Broess Coniod

£ Het [orfigumd
 [Enabied
i Dranbied

¥ Pieruame Token ﬂ
¥ Change Token Password

 Urkoek: Token

¥ Deletn Token Conieed

F Viewr Token nfmmaton

F Disconrect S slebet & oksn Vitual

F Hel

F hudvanced View

F Readsi Settingt

I Corneet S aletiet 6T oker Vitusl |

Epervirat Setirg | li=d Sietling I

[k ]| ceest | aeow |

10. Configuration Properties / SafeNet Authentication Client Tools UI Access Control List
SAC 8.3 Build 73 - Administrator's Guide, 007-012450-001 - Revision C, ©2014 SafeNet, Inc. O MC« 248 ) W



The following settings are written to the appropriate folder’s
SafeNet\Authentication\SAC\AccessControl registry key.

Access Control Feature ADM File Setting Registry Key Command Line
All access control features Values: Values: Cannot be set by
listed below command line installation.
Selected - The feature 1 (True) - The feature is
is enabled enabled.
Not selected - The 0 (False) - The feature is
feature is disabled. disabled.
Default: Selected, Default: 1(True), except
except where indicated where indicated in the table
in the table

In the following table, the Access Control Feature column displays the name in the Access Contro/
Properties window.

NOTE
All access control features are enabled by default, except where indicated in the table.

Access Control Registry Value Name Description
Feature
Rename Token RenameToken Enables/Disables the Rename Token feature in SafeNet

Authentication Client Tools.
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Access Control Feature
(Cont.)

Registry Value Name
(Cont.)

Description (Cont.)

Change Token Password
Unlock Token

Delete Token Content
View Token Information
Disconnect SafeNet
eToken Virtual

Help

Advanced View

Reader Settings
Connect SafeNet eToken

Virtual

Initialize Token

ChangePassword

UnlockEtoken

ClearEToken

ViewTokenInfo

DisconnectVirtual

ShowHelp

OpenAdvancedView

ManageReaders

AddeTokenVirtual

InitializeEToken

Enables/Disables the Change Token Password feature in
SafeNet Authentication Client Tools.

Enables/Disables the Unlock Token feature in SafeNet
Authentication Client Tools.

Enables/Disables the Delete Token Content feature in
SafeNet Authentication Client Tools.

Enables/Disables the View Token Information feature in
SafeNet Authentication Client Tools.

Enables/Disables the Disconnect SafeNet eToken Virtual
feature in SafeNet Authentication Client Tools.

Determines if the user can open the Help file in SafeNet
Authentication Client Tools.

Determines if the user can open the Advanced View in
SafeNet Authentication Client Tools.

Enables/Disables the Reader Settings feature in SafeNet
Authentication Client Tools.

Enables/Disables the Connect SafeNet eToken Virtual
feature in SafeNet Authentication Client Tools.

Enables/Disables the Initialize Token feature in SafeNet
Authentication Client Tools.
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Access Control Feature = Registry Value Name Description (Cont.)

(Cont.) (Cont.)

Import Certificate ImportCertificate Enables/Disables the Import Certificate feature in SafeNet
Authentication Client Tools.

Reset Default Certificate ClearDefaultCert Enables/Disables the Reset Default Certificate Selection

Selection feature in SafeNet Authentication Client Tools.

Delete Certificate DeleteCertificate Enables/Disables the Delete Certificate feature in SafeNet
Authentication ClientTools.

Export Certificate ExportCertificate Enables/Disables the Export Certificate feature in SafeNet
Authentication Client Tools.

Copy Certificate Data to CopyCertificateData Enables/Disables the Copy Certificate Data to Clipboard

Clipboard feature in SafeNet Authentication Client Tools.

Set Certificate as Default SetCertificateAsDefault Enables/Disables the Set Certificate as Default feature in
SafeNet Authentication Client Tools.

Set Certificate as Auxiliary = SetCertificateAsAuxilary Enables/Disables the Set Certificate as Auxiliary feature in
SafeNet Authentication Client Tools.

Log On as Administrator LoginAsAdministrator Enables/Disables the Log On as Administrator feature in
SafeNet Authentication Client Tools.

Change Administrator ChangeAdministratorPassword | Enables/Disables the Change Administrator Password

Password feature in SafeNet Authentication Client Tools.

Set Token Password SetUserPassword Enables/Disables the Set Token Password feature in

SafeNet Authentication Client Tools.
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Access Control Feature
(Cont.)

Registry Value Name
(Cont.)

Description (Cont.)

Token Password Retries

Administrator Password
Retries

Advanced Initialization
Settings

Change Initialization Key
during Initialization

Common Criteria Settings

System Tray - Unlock
Token

System Tray - Generate
oTP

System Tray - Delete
Token Content

AllowChangeUserMaxRetry

AllowChangeAdminMaxRetry

OpenAdvancedModeOfInitialize

ChangelnitializationKeyDuringl
nitialize

CommonCriteriaPasswordSetti
ng
TrayIconUnlockEtoken

GenerateOTP

TrayIconClearEToken

Enables/Disables the Logon retries before token is locked
feature (for the Token Password) in SafeNet
Authentication Client Tools.

Enables/Disables the Logon retries before token is locked
feature (for the Administrator Password) in SafeNet
Authentication Client Tools.

Enables/Disables the Advanced button in the Token
Initialization window in SafeNet Authentication Client
Tools.

Enables/Disables the Change Initialization key button in
the Advanced Token Initialization Settings window in
SafeNet Authentication Client Tools

Enables/Disables the Common Criteria option in the
Certification combo box.

Enables/Disables the Unlock Token feature in the SafeNet
Authentication Client Tray Menu

Enables/Disables the Generate OTPfeature in the SafeNet
Authentication Client Tray Menu

Enables/Disables the Delete Token Content feature in the
SafeNet Authentication Client Tray Menu.

Note: By default, this feature is Disabled
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Access Control Feature
(Cont.)

Registry Value Name
(Cont.)

Description (Cont.)

System Tray -Change
Token Password

System Tray - Select
Token

System Tray -Synchronize
Domain-Token Passwords

System Tray - Tools

System Tray - About

Enable Change IdenTrust
Identity

Enable Unblock IdenTrust
Passcode

Delete Data Object

TrayIconChangePassword

SwitcheToken

SyncDomainAndTokenPass

OpeneTokenProperties

About

IdentrusChangePassword

IdentrusUnlock

DeleteDataObject

Enables/Disables the Change Token Password feature in
the SafeNet Authentication Client Tray Menu.

Enables/Disables the Select Token feature in the SafeNet
Authentication Client Tray Menu.

Enables/Disables the Synchronize Domain Token
Passwordis feature in the SafeNet Authentication Client
Tray Menu.

Enables/Disables the 700/s menu item (open SafeNet
Authentication Client Tools) in the SafeNet Authentication
Client Tray Menu.

Enables/Disables the About menu item in the SafeNet
Authentication Client Tray Menu.

Enables/Disables the Change IdenTrust PIN feature in
SafeNet Authentication Client Tools.

Enables/Disables the Unlock IdenTrust feature in SafeNet
Authentication Client Tools.

Enables/Disables the Delete Data Object feature in
SafeNet Authentication Client Tools.
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Access Control Feature = Registry Value Name Description (Cont.)

(Cont.) (Cont.)
Note: This property VerisignClearEToken Enables/Disables the Verisign Clear Token feature in
cannot be set in the SafeNet Authentication Client Tools.

Access Control Properties
window. It must be set in
the registry key.

Note: This property VerisignSerialNumber Enables/Disables the Verisign Serial number feature in
cannot be set in the SafeNet Authentication Client Tools.

Access Control Properties

window. It must be set in

the registry key.
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SafeNet Authentication Client - BSec-Compatible Settings

The settings in this section are relevant for SafeNet Authentication Client BSec-compatible
configuration.

PKI Enroliment - Token Manager Utility (TMU) Settings

Description ADM File Setting Registry Value Command Line
Enable Token Enroliment Setting Name: Registry Value Name: Cannot be set by
Enable Token Enrollment EnrollEnabled command line
Determines if the token installation.
enroliment option is enabled  Values: Values:
in the Token Selected -Enabled 1 (True) - Enabled
Manager Utility. Not selected -Disabled 0 (False) - Disabled
Default: Selected Default: 1
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Description (Cont.)

ADM File Setting (Cont.)

Registry Value (Cont.)

Command Line

Enroll Token Containing Data

Determines how to proceed
when data is detected on the
token during token
enroliment.

Enable Enroliment Update

Determines if the option to
update after enrollment is
enabled in the Token
Manager Utility.

Enable P12 Import

Determines if the option to
import a PKC12 file is
enabled in the Token
Manager Utility.

Setting Name: Enroll Token
Containing Data

Values:

Always Initialize the token
Prompt user for action
Redirect to enrollment
update

Default: Always Initialize the
token

Setting Name: Enable
Enroliment Update

Values:
Selected -Enabled
Not selected -Disabled

Default: Selected

Setting Name: Enable P12
Import

Values:
Selected -Enabled
Not selected -Disabled

Default: Selected

Registry Value Name:
PKIEnrollCheck

Values:

1 - Continue initializing the
token

2 - Redirect to enrollment
update

3 - Prompt user for action

Default: 1

Registry Value Name:
PKIEnrollUpdateEnabled

Values:
1 (True) - Enabled
0 (False) - Disabled

Default: 1

Registry Value Name:
PKIEnrollP12Enabled

Values:
1 (True) - Enabled
0 (False) - Disabled

Default: 1
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Cannot be set by
command line
installation.

Cannot be set by
command line
installation.

Cannot be set by
command line
installation.
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Description (Cont.)

ADM File Setting (Cont.)

Registry Value (Cont.)

Command Line

Enable PKI Certificate
Enrollment

Determines if the certificate

enrollment option is enabled
in the Token Manager Utility.

Note:

Certificates can be enrolled to

a token only if appropriate
values are

defined in the following
settings:

¢ Enrollment Certificate Key

Size
¢ Enrollment CA Name

¢ Enrollment CA Certificate
Template

Setting Name: Enable PKI
Certificate Enrollment

Values:
Selected - Enabled
Not selected - Disabled

Default: Selected

Registry Value Name:

PKIEnrollEnabled
Values:

1 (True) - Enabled
0 (False) - Disabled

Default: 1
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Cannot be set by
command line
installation.
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Description (Cont.)

ADM File Setting (Cont.)

Registry Value (Cont.)

Command Line

Enroliment Certificate Key
Size

Defines the size of the
enrollment certificate key.

Enrollment CA Name

Defines the distinguished
name of the Certificate
Authority for certificate
enrollment.

Enrollment CA Certificate
Template

Defines the CA certificate
template for certificate
enrollment

Setting Name: Enrollment
Certificate Key Size

Values:

1 - 512 bits
2 - 768 bits
3 - 1024 bits
4 - 1280 bits
5 - 1536 bits
6 - 1792 bits
7 - 2048 bits

Default: 3 (1024 bit)

Setting Name: Enrollment
CA Name

Values:
String

Default: None

Setting Name: Enrollment
CA Certificate Template

Values:
String

Default: SmartcardUser

Registry Value Name:
EnrollmentCertificateKeySize

Values:

1 - 512 bits
2 - 768 bits
3 - 1024 bits
4 - 1280 bits
5 - 1536 bits
6 - 1792 bits
7 - 2048 bits

Default: 3 (1024 bit)

Registry Value Name:
EnrollmentCAName

Values:
String

Default: None

Registry Value Name:

EnrolimentCertificateTemplate

Values:
String

Default: SmartcardUser
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command line
installation.
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Cannot be set by
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Description (Cont.)

ADM File Setting (Cont.)

Registry Value (Cont.)

Command Line

Enable PKI Certificate
Reenroliment

Determines if the certificate
re-enrollment option is
enabled in the Token
Manager Utility.

Setting Name: Enable PKI
Certificate Reenrollment

Values:
Selected - Enabled
Not selected - Disabled

Registry Value Name:

PKIReEnrollEnabled

Values:
1 (True) - Enabled
0 (False) - Disabled

Cannot be set by
command line
installation.

Default: Selected Default: 1
Description ADM File Setting Registry Value Command Line
Enable Login Setting Name: Enable Login | Registry Value Name: Cannot be set by
Adminlogin command line
Determines if the Login Values: installation.
option is enabled. Selected - Enabled Values:

Not selected - Disabled

Default: Selected

1 (True) - Enabled
0 (False) - Disabled

Default: 1
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Description (Cont.)

ADM File Setting (Cont.)

Registry Value (Cont.) Command Line

Enable Change Password

Determines if the Change
Password option is enabled.

Enable Initialize Token

Determines if the Initialize
Token option is enabled.

Enable Test Token

Determines if the Test Token
option is enabled.

Setting Name: Enable
Change Password

Values:
Selected - Enabled
Not selected - Disabled

Default: Selected

Setting Name: Enable
Initialize Token

Values:
Selected - Enabled
Not selected - Disabled

Default: Selected

Setting Name: Enable Test
Token

Values:
Selected - Enabled
Not selected - Disabled

Default: Selected
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Registry Value Name:
AdminchangePassPhrase

Cannot be set by
command line
installation.
Values:

1 (True) - Enabled

0 (False) - Disabled

Default: 1

Registry Value Name:
AdmininitializeToken

Cannot be set by
command line
installation.
Values:

1 (True) - Enabled

0 (False) - Disabled

Default: 1

Registry Value Name:
AdmintestToken

Cannot be set by
command line
installation.
Values:

1 (True) - Enabled

0 (False) - Disabled

Default: 1
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Description (Cont.) ADM File Setting (Cont.) Registry Value (Cont.) Command Line

Enable Change Inactivity Setting Name: Enable Registry Value Name: Cannot be set by
Timer Change Inactivity Timer AdmineditInactivityTimer command line
installation.
Determines if the Change Values: Values:
Inactivity Timer option is Selected - Enabled 1 (True) - Enabled
enabled. Not selected - Disabled 0 (False) - Disabled
Default: Selected Default: 1
Enable Detailed Display Setting Name: Enable Registry Value Name: Cannot be set by
Detailed Display AdmindisplayObjects command line
Determines if the Detailed installation.
Display option is enabled. Values: Values:
Selected - Enabled 1 (True) - Enabled
Not selected - Disabled 0 (False) - Disabled
Default: Selected Default: 1
Enable Delete from Token Setting Name: Enable Delete = Registry Value Name: Cannot be set by
from Token AdmindeleteObjects command line
Determines if the Delete installation.
from Token option is enabled = Values: Values:
Selected - Enabled 1 (True) - Enabled
Not selected - Disabled 0 (False) - Disabled
Default: Selected Default: 1
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Description (Cont.)

ADM File Setting (Cont.)

Registry Value (Cont.)

Command Line

Enable Export to File

Determines if the Export to
File option is enabled.

Enable Edit Object

Determines if the Edit Object
option is enabled.

Enable Set Default Container

Determines if the Set to
Default Container option is
enabled.

Setting Name: Enable Export
to File

Values:
Selected - Enabled
Not selected - Disabled

Default: Selected

Setting Name: Enable Edit
Object

Values:
Selected - Enabled
Not selected - Disabled

Default: Selected

Setting Name: Enable Set
Default Container

Values:
Selected - Enabled
Not selected - Disabled

Default: Selected

Registry Value Name:
AdminsaveObjectsToFile

Values:
1 (True) - Enabled
0 (False) - Disabled

Default: 1

Registry Value Name:
AdmineditObjectAttributes

Values:
1 (True) - Enabled
0 (False) - Disabled

Default: 1

Registry Value Name:
Adminsetdefaultcontainer

Values:
1 (True) - Enabled
0 (False) - Disabled

Default: 1
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Description (Cont.)

ADM File Setting (Cont.)

Registry Value (Cont.)

Command Line

Enable Import P12
Determines if the Import

PKCS# 12 File option is
enabled.

Enable Change Label

Determines if the Change
Label option is enabled.

Setting Name: Enable
Import P12

Values:
Selected - Enabled
Not selected - Disabled

Default: Selected

Setting Name: Enable
Change Label

Values:
Selected - Enabled
Not selected - Disabled

Default: Selected

Registry Value Name:
AdminimportP12

Values:
1 (True) - Enabled
0 (False) - Disabled

Default: 1

Registry Value Name:
AdminRFU9

Values:
1 (True) - Enabled
0 (False) - Disabled

Default: 1
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Description (Cont.) ADM File Setting (Cont.) Registry Value (Cont.) Command Line
Hide Unblocking Password Setting Name: Hide Registry Value Name: Cannot be set by
Unblocking Password AdminRFU8 command line
Determines if the unblocking installation.
password characters are Values: Values:
displayed as asterisks as Selected - Password 1 (True) - Enabled
they are typed. characters are displayed as 0 (False) - Disabled
asterisks
Not selected — The actual Default: 1
password characters are
displayed
Default: Selected
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The following settings are written to the appropriate folder's safeNet\Authentication\SAC\Crypto
registry key.

Description ADM File Setting Registry Value Command Line
Key Management Setting Name: Registry Value Name: Cannot be set by

Key Management Key-Management-Security command line
Defines key creation, installation.
export, unwrap, and off- Values: Values: (String)

board crypto policies.
Compatible — maintain a non Compatible - has no effect,
restrictive policy that is current behavior is kept
compatible with previous
releases of SAC, and allows the = Optimized - do not generate

use of exportable keys and exportable keys, do not allow

legacy unwrap operations. keys to be exported, regardless
of how they were generated, do

Optimized - not allow Unwrap-PKCS1.5 or

Applies a restrictive policy that Unwrap-AES-CBC
prevents generation and use of

exportable keys, and blocks Default: Compatible
legacy unwrap operations.

Default: Legacy
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Description (Cont.)

ADM File Setting (Cont.)

Registry Value (Cont.)

Command Line

Unsupported Cryptographic
Algorithms and Features

The following list of
cryptographic algorithms
will not be supported by
SAC:

MD5, RC2, RSA<1024, DES,
GenericSecret<80, RC4<80,
ECC<160, ECB, RSA-RAW.

Setting Name:
Unsupported Cryptographic
Algorithms and Features

Values:

None — All SAC cryptographic
algorithms and features are
supported.

Obsolete algorithms — SAC
blocks the use of: MD5, RC2,
RSA<1024, DES,
GenericSecret<80, RC4<80,
ECC<160, ECB, RSA-RAW.

Default: None
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Registry Value Name:

Disable-Crypto
Values: (String)

None
Obsolete

Default: None

Cannot be set by
command line
installation.
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To allow organizations to enforce restrictive cryptographic policies when using SafeNet smartcard and
USB tokens, the following enhancements were introduced:

= Key Management Policy
m  Cryptographic Algorithms Policy

The motivation behind these enhancements:

m Legacy cryptographic schemes can cause organizations to fail current compliance requirements or
expose cryptographic weakness associated with obsolete algorithms and mechanisms.

The following enhancements were made to SafeNet Authentication Client to allow organizations to
block the use of such schemes, according to organizational policies.

¢ Enabling symmetric keys wrapping with other symmetric keys using GCM and CCM modes of
operation.

¢ Preventing legacy algorithms from being used by adding a key wrapping policy that enforces
the usage of only GCM and CCM modes of operation for symmetric encryption, and PKCS#1
v2.1 padding for RSA encryption.

m SafeNet introduced a new mechanism that allows administrators to prevent the use of legacy or
obsolete algorithms by third-party applications. These cryptographic algorithms conform to the
National Institute of Standards and Technology (NIST), preventing third-party applications from
using legacy or obsolete algorithms. By following NIST recommendations, the following algorithms
have been excluded and are considered as weak:
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Algorithms: RSA, ECC, AES, DES, 3DES, RC2, RC4, SHA2, SHA1, MD5, HMAC, GenericSecret.

Once a restrictive policy has been set, the use of SafeNet Authentication Client with the above
algorithms will be blocked. This might have implications on the way in which the third-party’s
applications currently work.

NOTE

Administrators must make sure that the third-party applications used by the organization are configured accordingly
and do no use one of the algorithms listed above, as they will be blocked.
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The following settings are written to the appropriate folder’s
SafeNet\Authentication\SAC\Identrus registry key.

Description ADM File Setting Registry Value Command Line
Override IdenTrust OIDs Setting name: Override Registry Value Name: Cannot be set by
IdenTrust OIDs Identrusldentity command line
Overrides SAC's list of installation.
IdenTrust OIDs Value: Value:
All OID values of non- All OID values of non-
Note: repudiation certificates, repudiation certificates,
separated by commas separated by commas

Users must log on to their
tokens whenever signing
with a certificate defined as
IdenTrust.

Default: No override Default: No override

To avoid having to
authenticate every time a
cryptographic operation is
required for certificates
containing IdenTrust OID
details, remove the OID
value from the registration
key value.
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